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Введение 

Целью работы является усвоение основных навыков при работе с 

математическим пакетом MathCad, ознакомится с методикой решения 

прикладных задач и их реализацией в современных математических пакетах. 

 

1. Теоретическая часть 

Документ программы MathCad называется рабочим листом. Он содержит 

объекты: формулы и текстовые блоки. В ходе расчетов формулы 

обрабатываются последовательно, слева направо и сверху вниз, а текстовые 

блоки игнорируются.  

Ввод информации осуществляется в месте расположения курсора. 

Программа MathCad использует три вида курсоров. Если ни один объект не 

выбран, используется крестообразный курсор, определяющий место создания 

следующего объекта. При вводе формул используется уголковый курсор, 

указывающий текущий элемент выражения. При вводе данных в текстовый 

блок применяется текстовый курсор в виде вертикальной черты. 

1.1 Ввод формул 

Формулы — основные объекты рабочего листа. Новый объект по 

умолчанию является формулой. Чтобы начать ввод формулы, надо установить 

крестообразный курсор в нужное место и начать ввод букв, цифр, знаков 

операций. При этом создается область формулы, в которой появляется 

уголковый курсор, охватывающий текущий элемент формулы, например имя 

переменной (функции) или число. При вводе бинарного оператора по другую 

сторону знака операции автоматически появляется заполнитель в виде черного 

прямоугольника. В это место вводят очередной операнд. 

Для управления порядком операций используют скобки, которые можно 

вводить вручную. Уголковый курсор позволяет автоматизировать такие 

действия. Чтобы выделить элементы формулы, которые в рамках операции 

должны рассматриваться как единое целое, используют клавишу ПРОБЕЛ. При 

каждом ее нажатии уголковый курсор «расширяется», охватывая элементы 

формулы, примыкающие к данному. После ввода знака операции элементы в 

пределах уголкового курсора автоматически заключаются в скобки. 

Элементы формул можно вводить с клавиатуры или с помощью 

специальных панелей управления. открывают с помощью меню View (Вид) или 

кнопками панели управления Math (Математика). Для ввода элементов формул 

предназначены следующие панели: 

 панель управления Arithmetic (Счет) для ввода чисел, знаков типичных 

математических операций и наиболее часто употребляемых стандартных 

функций; 

 панель управления Evaluation (Вычисление) для ввода операторов 

вычисления и знаков логических операций; 

панель управления Graph (График) для построения графиков; 

панель управления Matrix (Матрица) для ввода векторов и матриц и 

задания матричных операций; 
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панель управления Calculus (Исчисление) для задания операций, 

относящихсяк математическому анализу; 

панель управления Greek (Греческий алфавит) для ввода греческих букв 

(их можно также вводить с клавиатуры, если сразу после ввода 

соответствующего латинского символа нажимать сочетание клавиш CTRL+G, 

например [a][CTRL+G] — a, [W][CTRL+G]-Q); 

панель управления Symbolic (Аналитические вычисления) для управления 

аналитическими преобразованиями. 

Введенное выражение обычно вычисляют или присваивают переменной. 

Для вывода результата выражения используют знак вычисления, который 

выглядит как знак равенства и вводится при помощи кнопки Evaluate Expression 

(Вычислить выражение) на панели инструментов Evaluation (Вычисление). 

Знак присваивания изображается как «:=», а вводится при помощи кнопки 

Assign Value (Присвоить значение) на панели инструментов Evaluation 

(Вычисление). Слева от знака присваивания указывают имя переменной. Оно 

может содержать латинские и греческие буквы, цифры, символы «'», «_», а 

также описательный индекс. Описательный индекс вводится с помощью 

символа «> и изображается как нижний индекс, но является частью имени 

переменной, например Vinit. «Настоящие» индексы, определяющие отдельный 

элемент вектора или матрицы, задаются по-другому. 

Переменную, которой присвоено значение, можно использовать далее в 

документе в вычисляемых выражениях. Чтобы узнать значение переменной, 

следует использовать оператор вычисления. 

В следующем примере вычислена площадь круга с радиусом 2 

(использованы переменные г и s, значение постоянной п определено в 

программе MathCad по умолчанию). 

 
1.2. Ввод текста 

Текст, помещенный в рабочий лист, содержит комментарии и описания и 

предназначен для ознакомления, а не для использования в расчетах. Программа 

MathCad определяет назначение текущего блока автоматически при первом 

нажатии клавиши ПРОБЕЛ. Если введенный текст не может быть 

интерпретирован как формула, блок преобразуется в текстовый и последующие 

данные рассматриваются как текст. Создать текстовый блок без использования 

автоматических средств позволяет команда Insert > Text Region (Вставка > 

Текстовый блок). 

Иногда требуется встроить формулу внутрь текстового блока. Для этого 

служит команда Insert > Math Region (Вставка > Формула). 

Форматирование формул и текста 

Для форматирования формул и текста в программе MathCad используется 

панель инструментов Formatting (Форматирование). С ее помощью можно 

индивидуально отформатировать любую формулу или текстовый блок, задав 

гарнитуру и размер шрифта, а также полужирное, курсивное или подчеркнутое 

начертание символов. В текстовых блоках можно также задавать тип 

выравнивания и применять маркированные и нумерованные списки. 
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В качестве средств автоматизации используются стили оформления. 

Выбрать стиль оформления текстового блока или элемента формулы можно из 

списка Style (Стиль) на панели инструментов Formatting (Форматирование). Для 

формул и текстовых блоков применяются разные наборы стилей. 

Чтобы изменить стиль оформления формулы или создать новый стиль, 

используется команда Format > Equation (Формат > Выражение). Изменение 

стандартных стилей Variables (Переменные) и Constants (Константы) влияет на 

отображение формул по всему документу. Стиль оформления имени 

переменной учитывается при ее определении. Так, переменные хил; 

рассматриваются как различные и не взаимозаменяемы. При оформлении 

текстовых блоков можно использовать более обширный набор стилей. 

Настройка стилей текстовых блоков производится при помощи команды Format 

> Style (Формат > Стиль). 

1.3. Стандартные и пользовательские функции 

Произвольные зависимости между входными и выходными параметрами 

задаются при помощи функций. Функции принимают набор параметров и 

возвращают значение, скалярное или векторное (матричное). В формулах 

можно использовать стандартные встроенные функции, а также функции, 

определенные пользователем. 

Чтобы использовать функцию в выражении, надо определить значения 

входных параметров в скобках после имени функции. Имена простейших 

математических функций можно ввести с панели инструментов Arithmetic 

(Счет). Информацию о других функциях можно почерпнуть в справочной 

системе. Вставить в выражение стандартную функцию можно при помощи 

команды Insert > Function (Вставка > Функция). В диалоговом окне Insert 

Function (Вставка функции) слева выбирается категория, к которой относится 

функция, а справа — конкретная функция. В нижней части окна выдается 

информация о выбранной функции. При вводе функции через это диалоговое 

окно автоматически добавляются скобки и заполнители для значений 

параметров. 

Пользовательские функции должны быть сначала определены. 

Определение задается при помощи оператора присваивания. В левой части 

указывается имя пользовательской функции и, в скобках, формальные 

параметры — переменные, от которых она зависит. Справа от знака 

присваивания эти переменные должны использоваться в выражении. При 

использовании пользовательской функции в последующих формулах ее имя 

вводят вручную. В диалоговом окне Insert Function (Вставка функции) оно не 

отображается. 

 

2. Простые вычисления с использованием программы MathCad 

 

Задача. Найти ребро куба, равновеликого шару, площадь поверхности 

которого равна площади боковой поверхности прямого кругового конуса, у 

которого высота вдвое меньше, чем длина образующей. Объем этого конуса 

равен 1. 
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Анализ. Основные геометрические формулы, используемые при расчете. 

Объем конуса —
hrV 2

3

1


. 

Площадь боковой поверхности конуса — rlS  . 

Соотношение в конусе между радиусом основания, высотой и длиной 

образующей —
222 lhr  . 

Площадь поверхности шара —
24 RV  . 

      Объем шара —

3

3

4
RV 

. Объем куба -
3aV  . 

Откройте панель инструментов Arithmetic (Счет) щелчком на кнопке 

ArithmeticToolbar (Панель инструментов Счет) на панели инструментов Math 

(Математика) илис помощью команды View > Toolbars > Arithmetic (Вид > 

Панели инструментов > Счет). 

Для удобства расчета будем обозначать каждую из вычисляемых величин 

отдельной переменной. Объем конуса обозначим как V и присвоим ему 

значение l.Оператор присваивания вводится символом «> или кнопкой Assign 

Value (Присвоить значение) на панели инструментов Arithmetic (Счет). Итак, 

надо ввести В документе появится полноценный оператор присваивания: 

V:=1. 

Путем несложных преобразований получим, что радиус основания конуса 

можно вычислить по формуле 

3
3






V
r

 
Вводить эту формулу следует слева направо. Порядок ввода этой формулы 

следующий: Сначала вводим знак корня произвольной степени: кнопка Nth Root 

(Корень данной степени) на панели инструментов Arithmetic (Счет) или 

комбинация клавиш CTRL+\. Щелкните на черном квадратике, стоящем на 

месте показателя степени, и введите цифру 3. Щелкните на квадратике, 

замещающем подкоренное выражение, нажмите клавиши [V][*]. Введите знак 

квадратного корня: кнопка Square Root (Квадратный корень) на панели 

инструментов Arithmetic или клавиша [\] — и цифру 3. Прежде чем вводить 

знаменатель, дважды нажмите клавишу ПРОБЕЛ. Обратите внимание на синий 

уголок, который указывает на текущее выражение. Предполагается, что знак 

операции связывает выбранное выражение со следующим. В данном случае это 

безразлично, но в целом этот прием позволяет вводить сложные формулы, 

избегая ручного ввода дополнительных скобок. Нажмите клавишу [/]. Чтобы 

ввести число я, можно воспользоваться комбинацией клавиш CTRL+SHIFT+P 

или соответствующей кнопкой на панели инструментов Arithmetic (Счет). 

На экране появится следующая надпись: 

3
3






V
r

. 

5. Введите формулы для вычисления длины образующей и площади 

боковой поверхности конуса: 
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3

2


r
l

;    lrS   . 

Указание знака умножения между, переменными обязательно, так как 

иначе MathCad сочтет, что указана одна переменная с именем из нескольких 

букв. 

Для вычисления радиуса шара R введите формулу 4

S
R 

. 

Для вычисления объема шара введите формулу

3

3

4
RW 

. 

Использовать переменную V  во второй раз не следует, так как теперь мы 

определяем совершенно другой объем. 

 

8. Заключительная формула  
3 wa   позволит получить 

окончательный результат. После этого снова наберите имя переменной а и 

нажмите клавишу = или щелкните на кнопке Evaluate Expression (Вычислить 

выражение) на панели инструментов Arithmetic (Счет). После формулы 

появится знак равенства и вычисленныйрезультат. 

a=0.7102 

Вычислять можно как действительные, так и комплексные выражения. 

Обозначение мнимой единицы (i) следует вводить непосредственно после 

числового коэффициента, который нельзя опускать, даже если он равен 

единице. 

Вернитесь к самому первому выражению и отредактируйте его. Вместо 

значения 1 присвойте переменной значение 8. Сразу же перейдите к последней 

введенной формуле и обратите внимание, что результат расчета сразу же стал 

отражать новые начальные данные. 

 

3. Физические вычисления с использованием единиц измерения 

Постановка задачи. Теплоизолированный космический аппарат, 

находящийся на орбите Земли, имеет на борту приборы с электрической 

мощностью, которая может изменяться в ходе работы от N1 = 75 Вт (дежурный 

режим) до N2 = 200 Вт (сеанс связи). С целью обеспечения предсказуемого 

теплового режима в теплоизоляции сделано отверстие площадью S1 , на 

которое попадает поток солнечной энергии W=1400 Вт/
2м . Полученная энергия 

излучается аппаратом через это и дополнительное отверстие в теплоизоляции с 

площадью S2 в режиме «черного тела». Каковы должны быть площади 

отверстий, если допустимый диапазон температур для оборудования, 

расположенного в аппарате, составляет 20-30 °С? 
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Анализ задачи. Минимальная температура аппаратуры соответствует 

режиму минимального тепловыделения. В этом случае поступающая мощность 

111 NWSQ  Излучаемая мощность )( 21

4

12 SSTQ  , где T1 — минимальная 

допустимая температура в градусах Кельвина. В условиях теплового баланса 

эти мощности должны быть равны. 

Режим максимального тепловыделения соответствует максимальной 

температуре аппаратуры. В этом случае )( 21

4

221 SSTNWS   . 

Используя два полученных уравнения, получаем: 

)(

)(
4

1

4

2

4

21

4

12
1

TTW

TNTN
S






, )(

)()(
4

1

4

2

4

21

4

1212
2

TTW

TNTNNNW
S










 

Введите значения известных величин, присвоив их переменным с 

соответствующими именами. Вместо нижних индексов используйте просто 

дополнительную цифру в названии переменной. 

W: = 1400 watt/
2m , 

N1:= 75 watt            N2:=200 watt, 

T1:= (20+273) K    T2:= (30+273) K. 

 

Обозначения физических единиц присоединяйте к соответствующим 

значениям через знак умножения. Если нужное обозначение неизвестно, 

используйте команду Insert > Unit (Вставка > Единица измерения). Измеряемая 

величина выбирается в списке Dimension (Размерность), а нужная единица 

измерения — в спискеUnit (Единица измерения). 

Присвойте_ переменной σ  значение   постоянной   Стефана-Больцмана 

)1067,5(
42

8

Kм

Вm


 

 
Чтобы ввести греческую букву, используйте панель инструментов Greek 

(греческий алфавит) или введите соответствующую латинскую букву (в данном 

случае «s») и сразу же нажмите комбинацию клавиш CTRL+G. Так как 

специальной единицы для размерности этой константы не существует, ее 

следует составить из стандартных единиц методом умножения и деления. 

5. Введите полученные в ходе анализа формулы для вычисления 

площадей отверстий, присвоив полученные значения переменным S1 и S2. 
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Чтобы увидеть результаты вычислений, введите имя первой из 

рассчитанныхпеременных и нажмите клавишу [=]. Затем проделайте то же 

самое со второйпеременной. 
22 514.12;5679.01 mSmS   

Изменение значений параметров, заданных в условии задачи, приводит к 

автоматическому перерасчету формул. В частности, исследуйте, изменяя 

значениепеременной W, как изменяются требования к такому методу 

терморегуляциипри удалении аппарата от Солнца и приближении к нему (на 

орбите Венеры W=2700Bт/м2; на орбите Марса W=500 Bт/м2) 

Обратите внимание, что результат содержит единицы измерения в 

соответствиис системой единиц СИ. Используемая система единиц 

отображается в диалоговом окне Insert Unit (Вставка единиц измерения). 

Чтобы изменить используемую систему единиц, дайте команду Math > 

Options (Математика > Параметры) и в открывшемся диалоговом окне Math 

Options (Параметры расчета) выберите вкладку Unit System (Система единиц). 

Выберите систему CGS и посмотрите, как изменились результаты (они теперь 

выражаются в квадратных сантиметрах). Если выбрать американскую систему 

единиц (U.S.), то результат будет выражен в квадратных футах. 

4. Решение уравнений и систем 

Для численного поиска корней уравнения в программе MathCad 

используется функция root. Она служит для решения уравнений вида f(x) = 0, 

где f(x) — выражение, корни которого нужно найти, а х — неизвестное. Для 

поиска корней с помощью функции root, надо присвоить искомой переменной 

начальное значение, а затем вычислить корень при помощи вызова функции: 

R00T(f(x)). Здесь f(x) — функция переменной х, используемой в качестве 

второго параметра. Функция root возвращает значение независимой 

переменной, обращающее функцию f(x) в 0. Например: 

 
Если уравнение имеет несколько корней (как в данном примере), то 

результат, выдаваемый функцией root, зависит от выбранного начального 

приближения. 

Если надо решить систему уравнений (неравенств), используют так 

называемый блок решения, который начинается с ключевого слова given (дано) 

и заканчивается вызовом функции find (найти). Между ними располагают 

«логические утверждения», задающие ограничения на значения искомых 

величин, иными словами, уравнения и неравенства. Всем переменным, 

используемым для обозначения неизвестных величин, должны быть заранее 

присвоены начальные значения. 

Чтобы записать уравнение, в котором утверждается, что левая и правая 

части равны, используется знак логического равенства — кнопка Boolean Equals 

(Логически равно) на панели инструментов Evaluation (Вычисление). Другие 

знаки логических условий также можно найти на этой панели. 
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Заканчивается блок решения вызовом функции find, у которой в качестве 

аргументов должны быть перечислены искомые величины. Эта функция 

возвращает вектор, содержащий вычисленные значения неизвестных. 

Например: 

 

 
 

5. Работа с матрицами 

Векторы и матрицы рассматриваются в программе MathCad как 

одномерные и двумерные массивы данных. Число строк и столбцов матрицы 

задается в диалоговом окне Insert Matrix (Вставка матрицы), которое открывают 

командой Insert > Matrix (Вставка > Матрица). Вектор задается как матрица, 

имеющая один столбец. 

После щелчка на кнопке ОК в формулу вставляется матрица, содержащая 

вместо элементов заполнители. Вместо каждого заполнителя надо вставить 

число, переменную или выражение. 

Для матриц определены следующие операции: сложение, умножение на 

число, перемножение и прочие. Допустимо использование матриц вместо 

скалярных выражений: в этом случае предполагается, что указанные действия 

должны быть применены к каждому элементу матрицы, и результат также 

представляется в виде матрицы. Например, выражение М+3, где М— матрица, 

означает, что к каждому элементу матрицы прибавляется число 3. Если 

требуется явно указать необходимость поэлементного применения операции к 

матрице, используют знак векторизации, для ввода которого служит кнопка 

Vectorize (Векторизация) на панели инструментов Matrix (Матрица). Например: 

 

                      >обычное произведение матриц. 

— поэлементное произведение матриц с использованием векторизации. 

Для работы с элементами матрицы используют индексы элементов. 

Нумерация строк и столбцов матрицы начинается с нуля. Индекс элемента 

задается числом, переменной или выражением и отображается как нижний 

индекс. Он вводится после щелчка на кнопке Subscript (Индекс) на панели 

инструментов Matrix (Матрица). 

Пара индексов, определяющих элемент матрицы, разделяется запятой. 

Иногда (например, при построении графиков) требуется выделить вектор, 

представляющий собой столбец матрицы. Номер столбца матрицы 
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отображается как верхний индекс, заключенный в угловые скобки, например 

М<0>. Для его ввода используется кнопка Matrix Column (Столбец) на панели 

инструментов Matrix (Матрица). 

Чтобы задать общую формулу элементов матрицы, используют диапазоны. 

Диапазон фактически представляет собой вектор, содержащий арифметическую 

прогрессию, определенную первым, вторым и последним элементами. Чтобы 

задать диапазон, следует указать значение первого элемента, через запятую 

значение второго и через точку с запятой значение последнего элемента. Точка 

с запятой при задании диапазона отображается как две точки (..). Диапазон 

можно использовать как значение переменной, например х := 0,001..1 

Если разность прогрессии равна единице (то есть, элементы просто 

нумеруются), значение второго элемента и соответствующую запятую 

опускают. Например, чтобы сформировать по приведенной выше формуле 

матрицу размером 6x6, перед этой формулой надо указать i := 0..5 j := 0..5. При 

формировании матрицы путем присвоения значения ее элементам, размеры 

матрицы можно не задавать заранее. Всем неопределенным элементам 

автоматически присваиваются нулевые значения. Например, формула М5 5 := 1 

создает матрицу М размером 6x6, у которой все элементы, кроме 

расположенного в правом нижнем углу, равны 0. 

Векторы и матрицы. 

Задача. Разложить вектор по 
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Анализ. Первый этап решения задачи состоит в нахождении собственных 

значений и собственных векторов данной матрицы. Затем необходимо найти 

вектор T

такой что VTS


 , где S — матрица, столбцы которой представляют 

собой собственные вектора матрицы М. 

1. Запустите программу MathCad. 

2.Создайте матрицу М. Начните запись оператора присваивания, а для 

ввода правой части нажмите комбинацию клавиш CTRL+M, воспользуйтесь 

командой Insert >Matrix (Вставка > Матрица) или щелкните на кнопке Matrix or 

Vector (Матрицаили вектор) на панели инструментов Matrix (Матрица). 

3.В открывшемся диалоговом окне Insert Matrix (Вставка матрицы) укажите 

число строк и столбцов (по три) и щелкните на кнопке ОК. 

4.Введите значения элементов матрицы в отведенные места.  

5.Аналогичным образом сформируйте векторV


. Он будет представлять 

собойматрицу, имеющую только один столбец. 

6.Собственные значения квадратной матрицы можно получить при помощи 

функции eigenvals. Результатом ее работы является вектор собственных 

значений, присвойте его переменной L. 
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7.Функция eigenvec позволяет получить собственный вектор, 

соответствующийданному собственному значению. Ей нужны два параметра: 

матрица, для которой ищется собственный вектор, и собственное значение, 

которому он соответствует. Чтобы записать собственные вектора в качестве 

столбцов матрицы S, надо присвоить вычисленное значение столбцу матрицы. 

Столбцы матрицы в программе MathCad выбираются специальным верхним 

индексом, заключенным в угловые скобки. Чтобы ввести номер столбца, 

нажмите комбинацию клавиш CTRL+6 или щелкните на кнопке Matrix Column 

(Столбец) на панели инструментов Matrix (Матрица), после чего введите номер 

нужного столбца матрицы. Будьте внимательны — столбцы и строки матрицы 

нумеруются начиная с нуля. 

S<0> 

8. В правой части оператора присваивания надо указать собственное 

значениематрицы. Собственные значения являются элементами вектора L. 

Номер элемента указывается как нижний индекс. Для ввода нижнего индекса 

нажмите клавишу [ или воспользуйтесь кнопкой Subscript (Индекс) на панели 

инструментов Matrix. Итоговый оператор для первого собственного вектора 

будет выглядетьследующим образом: 

S<0>:=eigenvec(M,L0). 

Аналогично задайте операторы для второго и третьего собственных 

значений. 

9. Для нахождения коэффициентов при собственных векторах в 

разложении необходимо решить систему линейных уравнений. Ее удобно 

записать в матричнойформе. Создайте вектор Т с  тремя элементами. Величины 

этих элементов значения не имеют. 

Запишите ключевое слово given. 

Ниже запишите матричное уравнение ST=V .Знак логического равенства 

введите с помощью комбинации клавиш CTRL+=. 

Найдите коэффициенты в разложении при помощи функции find. 



















4606.1

4472.0

1865.0

)(Tfind

 
 

∆ Мы научились производить операции с векторами и матрицами, 

использовать соответствующие функции, выделять столбцы матриц и 

отдельные элементы. Матричная запись часто позволяет представить задачу в 

более удобной форме. 

 

6. Аналитические вычисления 

 

Задача 1. На приведенной схеме сопротивление RR является переменным. 

Определить, как меняется ток между точками А и В в зависимости от величины 

этого сопротивления. 
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Анализ. Перенумеровав сопротивления в указанном порядке и 

воспользовавшись законами Кирхгофа, получим систему уравнений, 

позволяющую найти величины токов. 

 

 

 

Эту систему надо решить, не подставляя 

конкретных значений вместо параметров R, RR и Е. 

Запустите программу MathCad. 

Введите ключевое слово given. 

3. Введите уравнения системы, полученной в ходе анализа. Обозначьте 

неизвестныетоки переменными I0,I1,I2,I3,I4. Фиксированное сопротивление R 

обозначьтепеременной R0. Обратите внимание, что присваивать начальные 

значения токовили задавать значения переменных R0,RR и E не требуется. 

4.Введите функцию find, перечислив в качестве параметров неизвестные 

I0,I1,I2,I3,I4. Затем введите оператор аналитического вычисления, который 

выглядиткак стрелка, направленная вправо, и вводится комбинацией клавиш 

CTRL+. иликнопкой Evaluate Symbolically (Вычислить аналитически) на панели 

инструментовEvaluation (Вычисление). 

5.Щелкните за пределами данного блока, и программа MathCad произведет 

аналитическое решение системы уравнений. 
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   Полученный результат позволяет провести полный анализ схемы. Задача 

2. Найти все корни уравнения: 

(1+y-y2)2+y=2 

Анализ. Это уравнение четвертого порядка. Легко подобрать один корень 

(у = 1). Остающееся уравнение третьего порядка не имеет рациональных 

корней, так что поиск других корней этого уравнения — дело непростое. 

Неясно даже, сколько еще действительных корней имеет данное уравнение. 

Результаты численного решения зависят от подбора начального приближения и 

поэтому не гарантируют отыскания всех корней уравнения. Мы же решим это 

уравнение аналитически. 

Введите заданное уравнение. Чтобы раскрыть скобки, дайте команду 

Symbolics >Simplify (Аналитические вычисления >Упростить). 

Выделите в полученном уравнении независимую переменную (в данном 

случае y) и дайте команду Symbolics > Variable > Solve (Аналитические 

вычисления >Переменная > Решить). 

Программа MathCad выдаст вектор, элементами которого являются корни 

данного уравнения. 

Полученный результат содержит сложные комплексные радикалы, и его 

невозможно применить с пользой (нельзя даже точно сказать, являются ли 

корнидействительными или комплексными). Чтобы разделить действительную 

имнимую части, выделите результат вычисления целиком и дайте 

командуSymbolics > Evaluate > Complex (Аналитические вычисления > 

Вычислить > В комплексном виде). В результате запись станет более простой, 

но результат все-такиостанется трудным для восприятия. 

Следующий шаг — раскрытие скобок, в данном случае упрощение 

аргументовтригонометрических функций. Для этого примените команду 

Symbolics > Expand(Аналитические вычисления >Раскрыть). Только теперь 

станет ясно, что все корниуравнения действительные (все мнимые компоненты 

сократятся). Это наилучшая точная запись решения, которую можно получить с 

помощью программы MathCad. 

10. Чтобы получить результат в числовом виде, достаточно ввести в конце 

выражения (итогового или на любой из предыдущих стадий) команду 

вычисления (=). 
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7. Построение графиков 

Чтобы достроить двумерный график в координатных осях Х- Y, надо дать 

команду Insert > Graph > X-Y Plot (Вставка > График > Декартовы координаты). 

В области размещения графика находятся заполнители для указания 

отображаемых выражений и диапазона изменения величин. Заполнитель у 
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середины оси координат предназначен для переменной или выражения, 

отображаемого по этой оси. Обычно используют диапазон или вектор значений. 

Граничные значения по осям выбираются автоматически в соответствии с 

диапазоном изменения величины, но их можно задать и вручную. 

В одной графической области можно построить несколько графиков. Для 

этого надо у соответствующей оси перечислить несколько выражений через 

запятую. 

Разные кривые изображаются разным цветом, а для форматирования 

графика надо дважды щелкнуть на области графика. Для управления 

отображением построенных линий служит вкладка Traces (Линии) в 

открывшемся диалоговом окне. Текущий формат каждой линии приведен в 

списке, а под списком расположены элементы управления, позволяющие 

изменять формат. Поле Legend Label (Описание) задает описание линии, 

которое отображается только при сбросе флажка Hide Legend (Скрыть 

описание). Список Symbol (Символ) позволяет выбрать маркеры для отдельных 

точек, список Line (Тип линии) задает тип линии, список Color (Цвет) — цвет. 

Список Туре (Тип) определяет способ связи отдельных точек, а список Width 

(Толщина)—толщину линии. 

Точно так же можно построить и отформатировать график в полярных 

координатах. Для его построения надо дать команду Insert > Graph > Polar Plot 

(Вставка > График > Полярные координаты). 

Для построения простейшего трехмерного графика, необходимо задать 

матрицу значений. Отобразить эту матрицу можно в виде поверхности — Insert 

> Graph > Surface Plot (Вставка > График > Поверхность), столбчатой 

диаграммы — Insert > Graph > 3D Bar Plot (Вставка > График > Столбчатая 

диаграмма) или линий уровня — Insert > Graph > Contour Plot (Вставка > График 

> Линии уровня). 

Для отображения векторного поля при помощи команды Insert > Graph > 

Vector Field Plot (Вставка > График > Поле векторов) значения матрицы должны 

быть комплексными. В этом случае в каждой точке графика отображается 

вектор с координатами, равными действительной и мнимой частям элемента 

матрицы. Во всех этих случаях после создания области графика необходимо 

указать вместо заполнителя имя матрицы, содержащей необходимые значения. 

Для построения параметрического точечного графика командой Insert > 

Graph > 3D Scatter Plot (Вставка > График > Точки в пространстве) необходимо 

задать три вектора с одинаковым числом элементов, которые соответствуют х-, 

у- и z-координатам точек, отображаемых на графике. В области графика эти три 

вектора указываются внутри скобок через запятую. 

Аналогичным образом можно построить поверхность, заданную 

параметрически. Для этого надо задать три матрицы, содержащие, 

соответственно, х-, у- и г-координаты точек поверхности. Теперь надо дать 

команду построения поверхности Insert > Graph > Surface Plot (Вставка > 

График > Поверхность) и указать в области графика эти три матрицы в скобках 

и через запятую. Таким образом можно построить практически любую 
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криволинейную поверхность (например представленную на рис. 1), в том числе 

с самопересечениями. 

 
Рис.1 Пятикратно перекрученная замкнутая лента, заданная 

параметрически 

 

Задача. Используя результаты, полученные в предыдущем упражнении, 

построить график, отображающий экспериментальные данные и 

аппроксимирующую зависимость. Построить другой график, отображающий 

величину отклонения экспериментальных значений от аппроксимирующей 

прямой. 

Анализ. Для построения графика можно использовать функцию, заданную 

набором данных или формулой. Формулы для функций, полученных в 

результате проделанных расчетов, необходимо определить, прежде чем их 

можно будет использовать при построении графика. 

Запустите программу MathCad. 

Загрузите документ, созданный в предыдущем упражнении. 

Переместите точку ввода в нижнюю часть документа. 

Запишите формулу функции r(x) для определения координат точек, 

лежащихна аппроксимирующей прямой. Коэффициенты соответствующего 

уравнениябыли получены в предыдущем упражнении. 

r(x):=b0+b1. x. 

Нажмите клавишу [@], щелкните на кнопке X-Y Plot (Декартовы 

координаты) напанели инструментов Graph (График) или дайте команду Insert > 

Graph > X-Y Plot(Вставка » График > Декартовы координаты). В документе 

появится область длясоздания графика. 

Вместо заполнителя в нижней части графика укажите в качестве 

независимой переменной первый столбец матрицы data (data<0> или X). 

Вместо заполнителя слева от графика укажите, что по вертикальной оси 

должны откладываться значения из второго столбца матрицы data и 

определенная выше линейная функция r(х). В качестве разделителя 

используется запятая. Диапазон значений для осей координат выбирается 

программой MathCad автоматически. 
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Чтобы изменить вид автоматически построенного графика, дважды 

щелкните внутри него. Откроется диалоговое окно Formatting Currently Selected 

X-Y Plot(Форматирование графика в декартовых координатах). Первая запись в 

списке на вкладке Traces (Кривые) соответствует первой отображенной кривой. 

Для изменения записи используются поля под списком. 

9. Под столбцом Legend Label (Подпись) введите название графика. 

В раскрывающемся списке под столбцом Symbol (Маркер) выберите 

способ обозначения для отдельных точек. 

Под столбцом Туре (Вид линии) укажите, что необходимо пометить 

отдельныеточки (points), а не провести непрерывную линию. 

Выберите в списке вторую кривую и настройте ее отображение по своему 

вкусу. 

Установите флажок Hide Arguments (Скрыть параметры), чтобы не 

отображать названия осей. 

Сбросьте флажок Hide Legend (Скрыть подписи), чтобы включить 

отображение подграфиком заданных подписей кривых. 

В поле Title (Заголовок) на вкладке Labels (Надписи) задайте название 

графика ивключите режим его отображения: флажок Show Title (Показать 

заголовок). 

 
Рис. 2. График экспериментальных точек и аппроксимирующей прямой 

 Постройте график, на котором отображалась бы величина отклонения 

точекот линии приближения (b0+b1. X-Y). Отформатируйте его, используя те 

жесредства, что и в предыдущем случае. 

Заголовок и подписи, использующие русские буквы, могут отображаться 

неправильно. Коррекцию обеспечивает выбор шрифта, правильно 
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воспроизводящего кириллицу. Дайте команду Format > Equation (Формат > 

Выражение), в раскрывающемся списке Style Name (Имя стиля) выберите пункт 

Variables (Переменные) и щелкните на кнопке Modify (Изменить). Для задания 

шрифта используйте поле со списком Шрифт. 

Для построения трехмерных графиков рассмотрим задачу. 

Задача. Изобразить на графике приблизительную форму электронных 

облаков в атомах. 

Анализ. По современным представлениям электронные уровни в атоме 

определяются четырьмя квантовыми числами. Форма электронного облака 

определяется двумя из этих чисел: 

число l определяет тип орбитали (значения 0-3 соответствуют s-, p-, d- и f- 

орбиталям ); 

число т определяет магнитный момент электрона и может изменяться в 

диапазоне от –l до l. 

При m=0 форма электронного облака определяется на основе многочленов 

Лежандра первого рода: 

l

l

l

l
x

dx

d

l
xP )1(

!2

1
)( 2 




где l — степень многочлена. 

В этом случае
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Параметрическое задание соответствующей поверхности имеет следующий 

вид: 
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sinsin)(),(

cossin)(),(







Yz

Yy

Yx

 
Углы θ,    изменяются в диапазоне от 0 до 2π. 

Запустите программу MathCad. 

Определите переменную l , которая укажет тип орбитали. 

l:=3 

3. Построение поверхности будем производить по точкам. Задайте два 

диапазона,которые будут определять изменение параметров θ,  , задающих 

поверхность.Удобно определить границы диапазона в целых числах (через 

точку с запятой,на экране изображаются две точки), а затем произвести 

перемасштабированиена отрезок [0; 2 π]. 

100

2
:,

100

2
:

100..0:,100..0:





 



ji

ji

ji

 
4. Определите двумерные матрицы, определяющие значения координат х, у 

и z, взависимости от значения параметров. Используйте названия переменных 

ХО,Y0 и Z0. 
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Дайте команду Insert > Graph > Surface Plot (Вставка * График > 

Поверхность) или воспользуйтесь кнопкой Surface Plot (Поверхность) на панели 

инструментовGraph (График) 

 
 Рис.3 Трехмерное изображение электронной f-орбитали 

В появившейся области графика вместо заполнителя укажите имена 

отображаемых матриц через запятую, заключив все их в скобки: (XO,YO,ZO). 

Чтобы изменить формат построенного графика, дважды щелкните на его 

области.Откроется диалоговое окно 3-D Plot Format (Формат трехмерного 

графика). 

На вкладке General (Общие) установите флажок Equal Scales (Равный 

масштаб),чтобы обеспечить одинаковый масштаб по осям координат. 

На вкладке Appearance (Оформление) установите переключатель Fill 

Surface(Заливка поверхности), чтобы обеспечить заливку построенной 

поверхности. 
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На вкладке Lighting (Подсветка) включите режим освещения поверхности. 

Установите флажок Enable Lighting (Включить подсветку), отключите все 

источникисвета, кроме первого. 

На панели Light Location (Размещение источника) задайте координаты 

источникасвета. Используйте кнопку < Применить>, чтобы сразу видеть 

последствия сделанных настроек. По окончании настройки закройте диалоговое 

окно щелчком накнопке ОК. 

Путем протягивания мыши в области графика измените направление осей 

координат, чтобы изображение было видно наиболее отчетливо. 

Изменяя значение l, можно увидеть форму электронных облаков для 

разных орбиталей, в том числе и не встречающихся в природе. 

 

8. Анализ результатов испытаний 

Задача. К пружине последовательно подвешивали грузы массой 1, 2, 3, ..., 

20 кг. В результате был получен список величин удлинения пружины (в 

миллиметрах). Определить основные статистические параметры полученного 

набора измерений. Рассчитать жесткость пружины и массу узла, 

использованного для крепления грузов к пружине, воспользовавшись методом 

наименьших квадратов. 

Анализ. Для решения этой задачи достаточно использовать стандартные 

средства статистических вычислений, имеющиеся в программе MathCad. 

Теоретически, растяжение пружины определяется формулой k • х = (т + т0) • g. 

Если определить статистическими методами коэффициенты a и b в уравнении х 

= а • т + b, то получим: 

k= a

b
m

a

g
0,

. 

1.Запустите программу MathCad. 

2.Введите таблицу данных, предназначенных для статистического анализа, 

какматрицу с двумя столбцами, первый из которых содержит веса грузов, а 

второй — значения растяжения пружины. 

3.Определите число точек в наборах данных с помощью функции rows. 

n:=rows(data)  n=20 

    4.Вычислите среднее растяжение пружины в ходе эксперимента с 

помощью функции mean. 

                    Y:=data<1>  mean(Y)=31.645. 

5.Вычислите медиану значений растяжения пружины при помощи функции 

median. 

Median(Y)=30.6 

Вычислите среднеквадратичное отклонение и дисперсию величины 

растяженияпружиныпри помощи функции . 

Stdev(Y)=17.4041,  stdev(Y)2=302.9025 

Определите коэффициенты линейного уравнения являющегося наилучшим 

приближением для данных наборов данных. Функция slope позволяет 

вычислить коэффициент наклона прямой, а функция intercept — свободный 

член. 
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                X:=data<0>    

             b0:=entercept(X,Y)   b0=0.0132 

             b1:=slope(X,Y)    b1=3.0126 

8.Определите жесткость пружины: 

k=7.448. 105(H/м) 

9.Определите массу узла крепления: 

m=4.36779(г) 

10. Сохраните созданный документ для использования в следующем 

упражнении. 

 

9. Решение дифференциальных уравнений 

Задача. Найти функцию у(х), удовлетворяющую дифференциальному 

уравнению 

xxy
dx

dy
cos

и имеющую значение 0 при х = 0. 

Анализ. Это простое дифференциальное уравнение допускает точное 

аналитическое решение, однако в данном упражнении предполагается 

использование стандартной функции программы MathCad, осуществляющей 

численное решение данного уравнения. Результат вычислений можно после 

этого сравнить с точным решением. 

Задайте начальное значение функции как элемент вектора у, размерность 

которогосоответствует числу решаемых уравнений (в данном случае единице): 

y0 := 0. 

Создайте функцию Т (х, y), которая вычисляет значение производной при 

заданных значениях независимой переменной и неизвестной функции: 
)cos(:),( 0 xxyyxT   

Определите начальное (точка 0) и конечное значение отрезка 

интегрирования. 

a:=0, b:=12π. 

Укажите число шагов интегрирования. 

K:=20. 

Вычислите численное решение уравнения при помощи функции rkfixed. 

Z:=rkfixed (y, a, b, K, T). 
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Рис.4 Графики численного и точного решения дифференциального 

уравнения 

Результат вычислений — матрица Z с двумя столбцами, первый из которых 

содержит значения независимой переменной, а второй — соответствующие 

значения функции. 

Постройте график полученного решения. 

Определите аналитическое решение данного уравнения при тех же 

начальных условиях. 

Нанесите аналитическую кривую на тот же график и сравните поведение 

численного и точного решения. 

Измените число шагов, на которые делится отрезок интегрирования, и 

исследуйте, как изменяется результат расчета при уменьшении и увеличении 

этого параметра. 

 

Элементарные функции комплексного переменного. 

Целая положительная степень комплексного числа 

Для того, чтобы ввести мнимую единицу i, наберите на клавиатуре 1i и 

щелкните мышью вне выделяющей рамки 

Для того, чтобы отобразить комплексное число в рабочем документе в 

алгебраической форме, щелкните в панели Symbolic по ключевому слову 

complex и введите в помеченной позиции имя комплексной переменной, и 

щелкните мышью вне выделяющей рамки 

│W│→4 

arg(W)→x 

Для того, чтобы отобразить комплексное число на комплексной плоскости, 

щёлкните в панели Graph по символу декартова графика, в открывшемся окне 

графиков введите в помеченной позиции возле оси ординат – имена мнимых 

частей, и щёлкните вне поля графиков. 
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Для того, чтобы установить стиль изображения, щёлкните по графику 

дважды и посмотрите метки в полях ввода, чтобы понять, как определён стиль 

изображения для приведенного графика.   

f(z):=z4                   z:=l-i 

W:=f(z)                  W complex→-4 

│z│→ 2             ( │z│)4→4 

arg(z)→




4

1

x        4.arg (z)→-x 

Корень n-й степени из комплексного числа 

Для того, чтобы ввести мнимую единицу i, наберите на клавиатуре 1i и 

щелкните мышью вне выделяющей рамки 

Для того, чтобы отобразить комплексное число в рабочем документе в 

алгебраической форме, щелкните в панели Symbolic по ключевому слову 

complex и введите в помеченной позиции имя комплексной переменной, и 

щелкните мышью вне выделяющей рамки 

│W│→ 4  

  


















2
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arg(W)→arg 

arg(w)=-0.393 

Для того, чтобы отобразить комплексное число на комплексной плоскости, 

щёлкните в панели Graph по символу декартова графика, в открывшемся окне 

графиков введите в помеченной позиции возле оси ординат – имена мнимых 

частей, и щёлкните вне поля графиков. 

Для того, чтобы установить стиль изображения, щёлкните по графику 

дважды и посмотрите метки в полях ввода, чтобы понять, как определён стиль 

изображения для приведенного графика.   

f(z):=
4 z                    z:=16. i 

W:=f(z)                   

W complex→     
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10. Решение задач аппроксимации. 

 

Создание матриц и векторов, необходимых для решения задачи МНК, 

производится по общим правилам. В свободном месте рабочего поля документа 

указывается имена объектов со знаком присваивания (см. таблицу). Через 

пункты меню Математика | Матрицы... (Math | Matrices...) вызывается 

диалог, в котором определяются количество Строк (Rows), Столбцов 

(Columns) и выбирается действие  Создать (Create). Здесь же можно Удалить 

(Delete) или Вставить (Insert) нужное число строк и столбцов. (Доступ к 

диалогу производится также нажатием клавиш [Ctrl] M.)  

Для формирования матрицы W удобно использовать функцию diag. 

 

Имя функции Возвращается... 

diag(V) Диагональная матрица, содержащая по диагонали 

элементы вектора V. 

 

На этапе задания значений над векторами и матрицами можно выполнять 

следующие операции: 

 

Операция Обозначение Клавиши Описание 

Присваивание := : Присваивание значений 

элементам вектора или 

матрицы. 

Нижний индекс 

вектора 

Vn [ Элемент вектора с 

номером n. 

Нижний индекс 

матрицы 

Mn,m [ ..., ... Элемент матрицы из 

строки n и столбца m. 

Верхний индекс M<n> [Ctrl]6 Извлечение столбца n из 

M (возвращается вектор). 

Векторизация 

M  [Ctrl]- Выполнение  всех 

операций над M 

поэлементно. 

 

По умолчанию массивы нумеруются с нулевого элемента. Чтобы изменить 

этот порядок, необходимо определить начальное значение встроенной 

переменной ORIGIN через пункт меню Математика | Встроенные 

переменные... (Math | Built-In Variables...). Можно также задать глобальное 

значение ORIGIN в любом месте документа. Например, чтобы установить этот 

параметр равным 1, необходимо напечатать в рабочем поле ORIGIN~1 (при 

этом в документе отобразится ORIGIN1). 

Вычисление значений вектора коэффициентов B = (XTWX)-1XTWY 

производится с помощью стандартных матричных операций. 
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Операция Обозначение Клавиши Описание 

Умножение 

матрицы на 

вектор 

MV * Произведение матрицы M 

на вектор V. Число 

столбцов M должно 

соответствовать числу 

строк V. 

Умножение 

матрицы на 

матрицу 

M1M2 * Произведение матриц M1 

и M2. Число столбцов M1 

должно соответствовать 

числу строк  M2. 

 

Операция Обозначение Клавиши Описание 

Сложение и 

вычитание 

M1+M2  

M1-M2 

+ 

- 

Сложение и вычитание 

соответствующих 

элементов массивов M1 и 

M2, имеющих одинаковую 

размерность. 

Транспониро-

вание 

MT [Ctrl]1 Транспонирование 

матрицы (вектора) M. 

Степень Mn ^ Целая степень n 

квадратной матрицы M 

(M-1 - обратная матрица). 

 

Пример решения общей линейной задачи МНК в матричной форме дан в 

приложении 2. 

Для вычисления коэффициентов уравнения, представляющего линейную 

комбинацию произвольных функций, используется стандартная функция linfit. 

 

Имя функции Возвращается... 

linfit(x, y, F) Вектор коэффициентов для линейной комбинации 

функций из вектора F, дающей наилучшую 

аппроксимацию данных из векторов x и y.  

 

Элементами вектора F(x) являются функции, линейно комбинирующие в 

искомом уравнении. Их скалярное произведение на элементы вектора 

коэффициентов F(x)B даст значение аппроксимирующей функции y(x). Пример 

использования функции linfit при определении коэффициентов полиномов 

различного порядка показан в приложении 3. 

Для определения коэффициентов нелинейного уравнения методом 

наименьших квадратов используется стандартная функция genfit, реализующая 

итерационную процедуру поиска решения. 

 

Имя функции Возвращается... 
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genfit(x, y, B0, F) Вектор m коэффициентов 0, ... m-1 функции, дающей 

наилучшую аппроксимацию данных из векторов x и y. 

F(x, B) - функциональный вектор. B0 - вектор начальных 

приближений коэффициентов. 

 

Элементами вектора F(x, B) размерностью m + 1 являются функция 

f(x, 0, ... 0) и её m частных производных по параметрам 0, ... m-1. Пример 

использования функции genfit для определения параметров нелинейных 

функций приведён в приложении 4. 

Нелинейную задачу МНК можно решить также путём минимизации 

сформированной функции невязки с помощью стандартной функции minerr. 

 

Имя функции Возвращается... 

minerr( 1, ... m) Значения коэффициентов 1, ... m искомой функции. 

 

До использования этой функции необходимо задать начальные 

приближения коэффициентов и сформировать систему уравнений в блоке Given 

(см. приложение 5). Число уравнений должно быть равно числу неизвестных 

(для удовлетворения этому требованию в блок допустимо включать фиктивные 

уравнения). Здесь же можно задать ограничения на значения коэффициентов. 

Для записи операций соотношения при формировании системы уравнений 

используются следующие комбинации клавиш: 

 

Условие Клавиши Условие Клавиши 

x = y [Ctrl]= x  y [Ctrl]3 

x < y > x  y [Ctrl]9 

x > y < x  y [Ctrl]0 

 

 

Работа заключается в построении эмпирических уравнений функции одной 

переменной y(x). Она выполняется студентом индивидуально по заданию, 

выданному преподавателем. Варианты заданий приведены в приложении 1. 

Работа выполняется в следующем порядке. 

1.  Задаётся число наблюдений n. Формируются вектора независимой и 

зависимой переменных x и y и диагональная весовая матрица W размерностью n 

 n. (По усмотрению преподавателя подбор эмпирических уравнений может 

производиться для разных весовых матриц.) 

2.  Набор значений x и y аппроксимируется полиномом степени m. Для 

этого формируются матрица наблюдений X размерность n  m+1 (с учётом 

единичного столбца). Коэффициенты полинома определяются путём решения 

общей линейной задачи МНК с помощью матричных преобразований. 

Определяются показатели качества аппроксимации Sy и Sbj. 

3.  Набор значений x и y аппроксимируется полиномом степени m, который 

представляется в виде линейной комбинации степенных функций. 
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Коэффициенты полинома определяются с помощью функции linfit. 

Определяется показатель качества аппроксимации Sy. 

4.  Набор значений x и y аппроксимируется заданной нелинейной 

зависимостью, коэффициенты которой находятся с помощью функции genfit. 

Определяется показатель качества аппроксимации Sy. 

5.  Набор значений x и y аппроксимируется заданной нелинейной 

зависимостью, коэффициенты которой находятся путём минимизации функции 

невязки с помощью функции minerr. Определяется показатель качества 

аппроксимации Sy. 

6.  Строится график, на который наносятся исходные данные x и y и 

расчётные величины, полученные по аппроксимирующим уравнениям. 

 

11. Программирование в системе Mathcad 

 

Программа в Mathcad - это именованное выражение (функция), 

составленное из нескольких программных операторов, которое имеет 

следующие преимущества: 

более гибкое, чем обычное выражение (так как программа может 

использовать управляющие структуры  подобно  циклам  и условным  

операторам); 

намного проще, чем обычный метод формирования сложного выражения. 

Программирование в Mathcad облегчает решение ряда задач. Это 

объясняется тем, что включенные в систему Mathcad Pro операторы 

программирования имеют основные конструкции языков высокого уровня: 

• оператор программирования Add Line (Добавить строку) предназначен 

для создания блоков выражений. Шаблон этого оператора выглядит так: 

Вертикальная черта означает, что операторы, примыкающие к ней, 

образуют один блок. Чтобы удлинить вертикальную черту и соответственно 

увеличить число меток, достаточно ввести в одну из них оператор Add Line; 

• оператор программирования ← (стрелка влево) служит для присваивания 

значения локальной переменной. Шаблон этого оператора выглядит так: 

■ ←  ■ 

Например, запись вида а ← 5 означает, что символу присвоено значение 5; 

• условный оператор программирования if (если) служит для ввода в 

программу условия. Шаблон этого оператора выглядит так: 

■  if ■ 

• оператор программирования otherwise (иначе) предназначен для 

введенияв условие дополнительной ветви. Шаблон этого оператора выглядит 

так: 

■  otherwise 

• оператор программирования for (для) предназначен для создания цикла 

призаранее известном числе итераций. Шаблон этого оператора выглядит так: 

for ■   ■ 

• оператор программирования while (пока) предназначен для создания 

цикла с условием выхода из него. Шаблон этого оператора выглядит так: 
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while ■ 

■ 

оператор программирования break (прервать) предназначен для остановки 

процесса выполнения программы; 

оператор программирования continue (продолжить) предназначен для 

продолжения вычислений; 

оператор программирования return (вернуть) предназначен для 

возвращения к выполнению цикла. Шаблон этого оператора выглядит так: 

return ■ 

• оператор программирования on error (на ошибке) предназначен для 

получения сообщения при наличии ошибки в выражении, в котором был 

размещен данный оператор. Шаблон оператора выглядит так: 

■  on error ■  
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ВВЕДЕНИЕ 
Основные понятия T-FLEX CAD 3D 

В системе T-FLEX CAD 3D в окне текущего чертежа могут быть расположены 2D вид 

и 3D вид чертежа одновременно. 

2D вид окна системы T-FLEX CAD 3D 

2D вид окна текущего чертежа служит для работы с двумерным чертежом. 2D вид 

полностью аналогичен окну текущего чертежа, рассматриваемому в двумерной 

системе T-FLEX CAD (см. часть1. Рис. 6). 

Следует иметь ввиду, что если вы находитесь в 2D виде текущего чертежа, то 

некоторые 3D команды будут недоступны, так как они относятся к конкретному 3D 

виду. 

3D вид окна системы T-FLEX CAD 3D 

3D вид служит для вывода трехмерных элементов чертежа системы T-FLEX CAD 3D. 

3D вид открывается с помощью разделителей, которые располагаются в левом нижнем 

и правом верхнем углу окна текущего чертежа рядом с полосами прокрутки 

соответственно слева и сверху. Для того, чтобы открыть 3D вид подведите курсор к 

разделителю (курсор превратится в две линии со стрелками, направленными в разные 

стороны). Нажмите  и удерживая клавишу мыши нажатой переместите курсор и 

отпустите клавишу мыши. На экране появится меню для выбора типа окна, которое вы 

хотите открыть (рис. 1).  

 
Рис. 1 

Либо можно сделать двойное нажатие мышки, указывая на 

разделитель. 

Установите параметр “3D окно» и нажмите кнопку [Ok]. В 

результате окно текущего чертежа будет разделено на два 

окна. В первом окне будет отображаться двумерный чертеж, а 

во втором трехмерная модель чертежа. 

Переход от 2D вида к 3D виду, расположенным в окне текущего чертежа 

осуществляется перемещением курсора в область соответствующего вида и нажатием 

. 

Вы можете открыть новое окно T-FLEX CAD с помощью команды WOpen. В этом 

случае вы можете определить, какой вид: 2D или 3D будет расположен в окне 

текущего чертежа. При вызове команды на экране появится такое же, как на рисунке 1 

меню для выбора типа окна, которое вы хотите открыть. 

Установите параметр “3D окно» и нажмите кнопку [Ok]. В результате на экране 

появится новое окно с 3D видом текущего чертежа. Таким образом, вы имеете два 

окна, в одном из которых окно текущего чертежа полностью занимает 2D вид, в 

другом - 3D вид. Переход от одного окна к другому осуще  ствляется нажатием 

<Ctrl><Tab>. 

Следует иметь ввиду, что если вы находитесь в 3D виде текущего чертежа, то 

большинство 2D команд будут недоступны. Чтобы они стали доступны, вам 

необходимо перейти в 2D вид текущего чертежа. 

В 3D виде вам доступны команды масштабирования (zoom), а также вы можете 

вращать 3D модель, удерживая нажатой правую клавишу мыши. В сочетании с 



нажатыми клавишами [Ctrl] и [Shift] вы сможете соответственно использовать 

режимы перемещения модели и отъезда-наезда. 

Для задания различных параметров и режимов работы в 3D окне используйте команды: 

 
 3VA  Автомасштабирование 3D сцены 

  
3VO  Параллельная проекция 

  
3VT  Перспективная проекция 

 
3VW  Показать реберную модель 

 
3VS Показать шейдинг 

 
3VR  Показать рендеринг 

 
3VH  Показать модель с удалением невидимых линий 

 
3VP  Задать параметры 3D вида 

2. 1. 3D сцена 

Все 3D элементы и трехмерные тела отображаемые в 3D виде окна текущего чертежа 

составляют 3D сцену. 

3D сцена - это пространственное отображение всех 3D элементов и трехмерных тел в 

3D виде окна текущего чертежа. 

  

 Рабочие плоскости 

Без создания рабочих плоскостей в T-FLEX CAD 3D нельзя создать ни один 3D 

элемент. 

Рабочие плоскости - плоскости, ориентированная определенным образом в 

трехмерном пространстве. Без создания рабочих плоскостей в T-FLEX CAD 3D 

невозможно построить трехмерную модель. Рабочие плоскости позволяют разделить 

двумерный чертеж на стандартные и дополнительные виды, применяемые в черчении. 

Стандартные рабочие плоскости 

Стандартные рабочие плоскости соответствуют шести стандартным видам, 

используемым в черчении. Стандартными рабочими плоскостями являются 

фронтальный вид, вид сзади, вид сверху, вид снизу, вид слева, вид справа 

Дополнительные рабочие плоскости 

Дополнительные рабочие плоскости соответствуют видам по стрелкам, 

применяемым в черчении (вид A-A, вид Е-Е повернуто). Дополнительные рабочие 

плоскости могут быть построены только когда задана хотя бы одна стандартная 

рабочая плоскость. При построении дополнительных рабочих плоскостей 

используются только прямолинейные виды по стрелкам, то есть без изгибов. 

Вспомогательные 3D элементы 

Вспомогательные 3D элементы и трехмерные модели могут быть созданы только при 

наличии рабочих плоскостей. 

3D узлы 

3D узлы - трехмерные точки. 3D узлы определяются в пространстве тремя 

координатами: по оси X, по оси Y, по оси Z. 3D узлы создаются с использованием 

узлов двумерного чертежа и рабочих плоскостей. Для создания 3D узла достаточно 

указать один узел на одной рабочей плоскости или два узла на разных рабочих 

плоскостях. Во втором случае два узла должны находится в проекционной связи между 

собой. 

3D профиль 



3D профиль - контур, который ориентирован в трехмерном пространстве, в 

соответствии с ориентацией какой-либо рабочей плоскости. 3D профиль задается с 

помощью двумерной штриховки и рабочей плоскости. 

3D система координат 

3D система координат - локальная система координат (ЛСК) трехмерных объектов 

одного чертежа. 3D система координат используется при вставке трехмерного 

изображения чертежа, в другой чертеж, в качестве 3D фрагмента. 3D система 

координат позволяет изменять ориентацию трехмерных тел вставляемого чертежа, по 

отношению к трехмерным телам чертежа, в который вставляется чертеж. Кроме этого 

ЛСК используется в операции копирования. Размер ЛСК может быть задан в параметре 

« Размер|Система координат» на закладке « 3D» команды STatus. 

Сечение 

Сечение позволяет увидеть внутреннюю структуру твердых тел (невидимые полости, 

пересечения внутренних отверстий и т.п.). Сечение задается набором узлов и рабочей 

плоскостью. Считается, что модель рассекается плоскостями, проходящими через 

узлы, и перпендикулярными рабочей плоскости. 

3D путь 

3D путь - расположенный в пространстве путь, имеющий начало и направление. 

Используется в операции создания трубопровода. 3D путь строится на основе 

одноконтурной штриховки, либо на основе одной или нескольких линий построения 

типа 2D путь. Ориентация в трехмерном пространстве задается посредством выбора 

соответствующей рабочей плоскости, а также узлов привязки. 

Источник света 

Источник света - элемент, освещающий изображение в 3D окне. Изображается в виде 

небольшого « излучающего» шара. Изображение источника света может быть скрыто 

при сохранении эффекта освещения. Источник света привязывается к 3D узлу. 

Направление также задается 3D узлом. Существует 3 типа источников света - 

точечный, направленный и прожектор. Для создания источника света используйте 

команду 3H. Необходимо также иметь в виду, что в освещении 3D изображения также 

участвует основной источник света, отключить который можно в команде 3VP. 

На основе вспомогательных 3D элементов с помощью операций создаются 

трехмерные тела (модели). 

 
Базовые операции создания твердых тел 
Базовые операции создания твердых тел используют вспомогательные 3D элементы 

для создания трехмерных тел (моделей). 

Операция выталкивания позволяет получить трехмерное тело перемещением 3D 

профиля на определенное расстояние, или на вектор заданный двумя 3D узлами. Тела, 

полученные данной операцией, будут называться телами выталкивания. 

Операция вращения 

Операция вращения позволяет получить трехмерное тело вращением 3D профиля 

вокруг заданной оси. При этом профиль и ось вращения должны лежать в одной 

плоскости. Тела, полученные данной операцией, будут называться телами вращения. 

Операция создания линейчатой поверхности 

Операция создания линейчатой поверхности позволяет получить трехмерное тело 

путем соединения двух 3D профилей линейчатой поверхностью. Количество сегментов 

двух 3D профилей должно совпадать. Также эта операции позволяет получать тела 

типа пирамиды 

Операция создания лофтинга 



Операция создания лофтинга предназначена для создания трехмерной модели путем 

создания линейчатой или сплайновой поверхности, проходящей через несколько 3D 

профилей. Необходимо отметить, что для создания лофтинга необходимо 

предварительно создать несколько 3D профилей, используя команду 3PR. 

Операция создания трубопровода 

Операция создания трубопровода позволяет получить трехмерное тело путем 

перемещения 3D профиля по 3D Пути. 

Операция создания спирали 

Операция создания спирали позволяет получить трехмерное тело типа спираль путем 

перемещения профиля по винтовой кривой. Профиль может быть ориентирован 

ортогонально оси спирали, либо ортогонально винтовой кривой. 

Операция создания пружины 

Операция создания пружины позволяет получить трехмерное тело типа пружина 

путем перемещения профиля-окружности вдоль винтовой кривой. При этом 

существует возможность задания « сжатия» и « шлифовки» на концах. Смотри 

команду “3SP» 

 

Операции над твердыми телами 
Операции над твердыми телами позволяют из простейших тел создавать более 

сложные тела. 

Булевы операции позволяют из твердых тел получать новые тела с помощью 

действий сложения, вычитания и пересечения. Любое действие производится над 

двумя телами. Действие сложение позволяет объединить два твердых тела в одно. 

Действие вычитание позволяет удалить из объема одного тела объем, занимаемый 

другим телом. Действие пересечение позволяет получить тело, которое является 

пересечением двух тел. 

Создание копии позволяет вам создавать копии 3D тел. Положение копии тела в 

пространстве определяется исходной и целевой локальной 3D системой координат. 

Создание 3D фрагмента позволяет вам вставлять в 3D сцену новые тела, которые 

были созданы в других чертежах. Над вставленными телами можно производить 

булевы операции, операции сечения. 

3D фрагмент является фрагментом системы T-FLEX CAD с той лишь разницей, что он 

имеет трехмерную модель, которую можно вставить в трехмерные модели других 

чертежей. По аналогии с фрагментом системы T-FLEX CAD 3D фрагмент системы T-

FLEX CAD 3D имеет точки привязки, которые называются 3D системы координат и 

определяют ориентацию вставляемой трехмерной модели в трехмерном пространстве 

другого чертежа. 

Создание массива позволяет создавать линейные массивы твердых тел, 

расположенные по направлению, заданному двумя 3D узлами. В результате операции 

получается единый набор тел, включая исходное тело. Этот набор может быть 

использован в любых других операциях над твердыми телами. 

Создание массива вращения позволяет создавать массивы твердых тел, 

расположенные по окружности. В результате операции получается единый набор тел, 

включая исходное тело. Этот набор может быть использован в любых других 

операциях над твердыми телами. 

Вставка внешней модели позволяет добавлять в текущую 3D сцену модели, 

хранящиеся на диске в формате. sat (ACIS). 

 

 

 



Метод создания трехмерной модели 
Создание трехмерной модели в T-FLEX CAD 3D предполагает наличие двумерного 

чертежа. Чертеж может быть выполнен в любом виде (эскиз, рабочий чертеж). 

Для отображения трехмерной модели необходимо создать в окне текущего чертежа 3D 

вид. 

Создание трехмерной модели начинается с задания рабочих плоскостей. Рабочие 

плоскости могут быть стандартными и дополнительными. Достаточным для создания 

трехмерной модели является наличие одной стандартной рабочей плоскости. 

С помощью использования рабочих плоскостей создаются вспомогательные 3D 

элементы: 3D узлы, 3D профили. Базовыми элементами для создания трехмерных 

узлов являются рабочие плоскости и 2D узлы системы T-FLEX CAD. 

Для создания 3D профилей используются рабочие плоскости и штриховки системы T-

FLEX CAD. После создания вспомогательных 3D элементов с использованием базовых 

операций создаются твердые тела. При создании трехмерных тел 3D точки и 3D 

профили могут выбираться по 2D виду и 3D виду окна текущего чертежа. При этом 

следует помнить, что если вы находитесь в 3D виде, то вам недоступен вызов 2D 

команд системы. Для их вызова необходимо перейти в 2D вид. И наоборот. После 

создания простейших твердых тел, используя операции над твердыми телами, вы 

можете получить более сложные тела. При работе в 3D виде вы можете вращать 3D 

сцену с помощью мыши. Для этого необходимо нажать  и, не отпуская клавишу, 

переместить курсор и отпустить клавишу. В результате 3D сцена повернется на 

определенный угол. Трехмерные тела в 3D сцене могут быть отображаться 4-мя 

способами: реберной моделью, с шейдингом (тоновой закраской), с удалением 

невидимых линий, а также с рендерингом (применением материалов). 

Когда вы создаете трехмерную модель, вы привязываетесь к двумерным 

параметрических элементам системы T-FLEX CAD. Таким образом, параметрическое 

изменение двумерного чертежа будет приводить к параметрическому изменению 

трехмерной модели. Пересчет трехмерной модели после изменения параметров 

двумерного чертежа может производится автоматически, если установлен 

соответствующий параметр в закладке “3D» команды “SO: Задать установки 

системы» , или по вашему требованию после вызова команды “3G - Обновить 

трехмерную модель» . 

Созданную трехмерную модель можно экспортировать в стандартные форматы DXF 

3D, ACIS SAT,IGES, STEP, STL, Windows BMP для передачи геометрии в более 

мощные системы и в системы создания программ для станков с ЧПУ. Для этого 

необходимо воспользоваться командой EXport. Вы можете рассчитать масс-

инерционные характеристики тел с помощью вызова команды “3M: Получить масс-

инерционные характеристики» . 

В результате параметрического изменения при пересчете трехмерной модели могут 

возникать ошибки, например: два тела не пересекаются, не может быть построена 

поверхность сглаживания. Сообщения об ошибках отображаются в окне диагностики. 

Рассчитать расстояние между телами, а также проверить сборочную модель на 

взаимное проникновение тел можно в команде « 3ME - Измерить расстояние, 

проверить на пересечение». 

 

Общие принципы работы с 3D командами 
При работе с 3D командами в T-FLEX CAD 3D следует иметь ввиду следующее: вызов 

каждой новой 3D команды не отменяет предыдущую команду, как это происходит с 2D 

командами в T-FLEX CAD 2D. 3D команды при последовательном вызове становятся 

вложенными друг в друга. При отмене последней команды система возвращает 



управление в предпоследнюю загруженную команду. Поэтому, желательно перед 

вызовом новой 3D команды осуществить выход из исполняемой 3D команды. 

В любой команде создания необходимо выполнить определенную последовательность 

действий для задания 3D элемента. Если вы задали все необходимые действия для 

задания 3D элемента, то в автоменю становится доступной опция 

 <Y> Подтвердить ввод. 

Создание и редактирование любого 3D элемента в 3D команде обязательно 

завершается подтверждением с помощью этой опции. 

Если не воспользоваться данной опцией, то 3D элемент не будет создан. 

При вызове любой 3D команды в автоменю появляется несколько опций, с помощью 

которых выполняются одни и те же действия для разных 3D команд: 

 <W> Игнорировать рабочую плоскость. 

С помощью этой опции при выборе какого-либо 3D элемента можно выбрать 

следующую рабочую плоскость, которой принадлежит выбираемый элемент. 

 <I> Игнорировать элемент. 

С помощью этой опции можно выбрать следующий ближайший элемент. 

 <Esc> Отменить последнее действие. 

С помощью этой опции можно вернуться на один шаг назад при задании какой-либо 

3D операции. 

 <Z> Выбрать элемент по имени. 

С помощью этой опции можно осуществить выбор элемента из появляющегося списка 

по имени. 

При работе с 3D командами следует иметь ввиду, что 3D элементы могут выбираться 

как по 3D виду, так и по 2D виду. Это относится в первую очередь к 3D узлам и 3D 

контурам, которые могут выбираться в 2D виде, соответственно, по узлам и 

штриховкам. Выбор отдельных 3D элементов в определенных случаях может быть 

осуществлен только по 2D виду. Например, при создании булевой операции между 

двумя телами, полученными операциями выталкивания или вращения, если 

необходимо изменить параметры тел выталкивания или вращения, то их можно 

выбрать только на 2D виде с помощью выбора соответствующих штриховок. 

4. 1. Редактирование 3D элементов 

При вызове любой команды редактирования 3D элемента в автоменю появляется 

следующий набор опций: 

 
<Esc> Отменить выбор. 

 
<A> Выбрать все элементы. 

 
 <Z> Выбрать элемент по имени. 

 
<I> Игнорировать элемент. 

 
<P> Изменить параметры элемента. 

 
<E> Редактировать элемент (при выборе данной опции вы попадаете в команду 

создания соответствующего элемента на этап, когда вы либо нажимаете 

, либо перезадаете объект). 

 
<Del> Удалить элемент (группу элементов). 

 
<X> Выйти из команды. 

При определенном выборе элементов часть команд может быть недоступна. 

Вы выбрали один элемент для редактирования. 



Элемент можно удалить, отредактировать его параметры (воспользовавшись либо 

окном диалога, либо системной панелью), игнорировать выбор элемента. 

Для редактирования (перезадания) элемента необходимо воспользоваться опцией 

 
<E> Редактировать элемент. 

После выбора этой опции вы окажетесь в команде создания данного элемента. Для 

редактирования элемента можно воспользоваться опциями, которыми вы пользовались 

при создании этого элемента, и перезадать выбранный элемент. 

Вы выбрали несколько элементов для редактирования. 

Отметим, что для множественного выбора наряду с пиктограммой  может 

использоваться комбинация <Ctrl> . Причем первое нажатие на элемент позволит его 

выбрать, а повторное - отменить его выбор. 

При множественном выборе элементов вы можете либо удалить их, либо поменять их 

параметры с помощью системной панели. 

4. 1. 1. Команда « STatus: Задать параметры чертежа».  

Закладка « 3D» 

Объединяет общие параметры, относящиеся к объемному моделированию. 

 Плотность сетки. Параметр, определяющий плотность сетки, используемой при 

визуализации. Чем меньше этот параметр, тем красивее получается модель, но время 

пересчета и прорисовки увеличивается. 

 Размер 3D узлов. Параметр, устанавливающий размер 3D узлов в пикселях при 

отображении в 3D виде окна текущего чертежа. 

 Размер систем координат. Параметр, устанавливающий размер 3D систем координат 

в единицах чертежа при отображении в 3D виде окна текущего чертежа. 

 Один цвет. При установке этого параметра все трехмерные модели будут 

прорисовываться одним цветом, который вы можете выбрать из меню. 

 Ориентация координат. Выбирается один из двух возможных стандартов: ANSY или 

ЕСКД. 

 Сохранять полные 3D данные в файле чертежа. При установке использовании 

этого параметра объемная модель будет сохранена вместе с чертежом и при открытии 

чертежа будет сразу загружена. В противном случае при каждом открытии чертежа 

происходит пересчет модели. Обратите внимание, что во втором случае вы уменьшаете 

размер файла, в котором хранится чертеж, но, возможно, увеличиваете время его 

загрузки. 

4. 1. 2. Команда « SO: Задать установки системы».  

Закладка « 3D» 

· Стандарт расположения видов. Выбирается один из двух возможных стандартов: 

ANSI (стандартные виды: вид спереди, вид снизу и вид справа) или ЕСКД 

(стандартные виды: вид спереди, вид сверху и вид слева). 

· Регенерация. Вы можете установить один из двух возможных режимов: 

 - Прозрачная. Пересчет трехмерной модели осуществляется автоматически при 

любом изменении двумерного чертежа. 

 - По запросу. Пересчет модели осуществляется только при вызове команды 3G. 

 Ускорение. 

Не создавать сетку. Если вы установите данный параметр, то для трехмерной модели 

будет рассчитываться только реберная сетка, а сетка визуализации будет рассчитаться 

только при вызове команд визуализации: шейдинг и рендеринг. В противном случае 

обе сетки рассчитываются одновременно при создании модели. 



Игнорировать сопряжения. При установке данного параметра все заданные вами в 

процессе создания объемной модели скругления не будут рассчитываться и 

отображаться. 

· Обработка ошибок. Данная группа параметров позволяет установить режим 

обработки ошибок. В системе существует окно диагностики ошибок при генерации 

трехмерной модели. В него заносится информация об имени операции, в которой 

замечена ошибка, а также излагается суть ошибки. Вы можете установить следующие 

параметры режима: 

 - Игнорировать. В данном случае генерация трехмерной модели будет завершена не 

зависимо от обнаруженных ошибок и в окно диагностики попадет полный список 

ошибок. 

 - Прервать. Генерация трехмерной модели будет прервана при обнаружении первой 

ошибки. 

 - Звуковой сигнал. При выборе данной опции обнаружение каждой ошибки будет 

сопровождаться звуковым сигналом. 



ПРАКТИЧЕСКАЯ РАБОТА №1 

ПОСТРОЕНИЕ МОДЕЛЕЙ ДЕТАЛЕЙ  И ОФОРМЛЕНИЕ 

ЧЕРТЕЖЕЙ 
 

В этой работе необходимо выполнить объемную модель деталь и получить указанные 

стандартные, дополнительные виды и разрезы. Вводная теоретическая часть суммирует 

основные сведения о способах построения различных типов проекций на основе объемной 

модели детали. Пример выполнения работы 

 
 

 

Для создания стандартных видов можно либо воспользоваться опцией «Создать стандартный 

вид» команды 3J «Создать 2D проекцию» (рис. 1), либо выбрать название вида из списка на 

панели свойств команды 3J (рис. 2). 

Для создания проекции, связанной с другой проекцией, ее нужно выбрать и отнести 

привязанный к курсору синий прямоугольник в нужную сторону, затем закрепить его 

положение щелчком мыши. 

Так как по умолчанию в автоменю нажата кнопка  «Установить/ разорвать проекционную 

связь», то создаваемый вид находится в проекционной связи с выбранным. Для размещения 

созданного вида в свободном месте листа надо отжать эту кнопку. Если необходимо 

установить проекционную связь с одной из проекции, следует воспользоваться опцией  и 

выбрать проекцию, на основе которой будет установлена проекционная связь. Для создания 

вида по стрелке, надо предварительно создать элемент оформления – выбрать из меню 

«Чертеж» пункт «Обозначение вида» и далее опцию «создать вид по стрелке», далее можно 

указать точки вектора направления взгляда. После чего в команде создания 2D вида надо 



выбрать элемент оформления «Вид по стрелке». Т.к. по умолчанию в автоменю нажата кнопка 

, то создаваемый вид будет скользить вдоль направления стрелки в обе стороны. Для 

размещения созданного вида в свободном месте листа надо отжать эту кнопку. Для 

восстановления проекционной связи достаточно снова нажать эту кнопку во время 

редактирования 2D проекции. 

 

 
 
 

 
 

 

 

 

 

 

 

 

Чтобы создать радиальный разрез надо создать элемент оформления – выбрать из меню 

«Чертеж» пункт «Обозначение вида» и далее опцию «Создать сложное сечение», затем (рис. 3) 

выбирать точки, через которые проходит линия разреза. После выбора последней точки 

необходимо нажать клавишу <End> или зеленую галочку в автоменю. При создании 

радиального разреза необходимо раскрыть закладку «Сечения» панели свойств команды 

«Создать 2D проекцию» (рис. 4), и в списке «Использовать сечения» выбрать значение «Разрез 

с разворотом/радиальный». 

Для создания изометрии с угловым вырезом необходимо создать в окне 3D сцены элемент 

построения – 3D сечение, соответствующее угловому вырезу (рис. 5), и затем применить это 

сечение вовремя создания 2D вида изометрии с помощью опции «Определить применяемые 

сечения» (рис. 6)  
 

 

 

 

 

Рис. 2 

Рис.1 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 
 

 

 

Создать 3D сечение удобнее всего командой 3SE «Построить сечение» на основе рабочей 

плоскости, аналогично команде SE при создании сложного сечения (рис. 3). Точки следует 

выбирать за пределами изображения (если необходимо, создав дополнительные построения), 

иначе тело дополнительно обрежется по границам 3D сечения. Если за основу создания 3D 

сечения взять 2D путь, то разрезать тело можно не только плоскими сегментами (рис. 7) 

Рис. 3 

Рис. 4 

Рис. 5 

Рис. 6 



 
 

 

При этом в свойствах создаваемого сечения можно установить галочку «Показывать на 3D 

виде» (рис. 8) 

 

 
 

Рис. 8 

 

Иногда   необходимо   совместить   половину   вида   с   половиной   разреза.   Для  этого   

можно воспользоваться опцией  «Создать местный разрез». Местный разрез создается на 

основе существующей проекции, по контуру наложенной на нее штриховки. Кроме того, 

необходимо указать положение плоскости местного разреза по глубине. Это делается выбором 

точки, через которую проходит плоскость местного разреза (рис. 9). 

Следует иметь в виду, что после применения местного разреза штриховка получает приоритет 

1 и перекрывает собой линии 2D проекции. Из-за этого возникает побочный эффект: 

штриховка перекрывает размерные и осевые линии под собой. Чтобы их сделать видимыми 

необходимо при простановке размеров и осевых выставить приоритет выше 2 в их свойствах и 

отметить галочку «по умолчанию». 

 

Рис. 7 



 
 

Рис. 9 

 

Результат применения местного разреза к виду спереди показан на рис. 10. 

 

  
 

Рис. 10 

 

Напомним, что спроецировать или применить разрезы можно не только ко всему телу   

(детали), но и к отдельным граням, наборам граней или ребер. 

Делается это с помощью опции «Выбрать элементы модели для проецирования». 

 

 



ПРАКТИЧЕСКАЯ РАБОТА №2 

СОЗДАНИЕ 3D МОДЕЛИ ПО СУЩЕСТВУЮЩЕМУ 

ЧЕРТЕЖУ НА ОСНОВЕ ОДНОЙ РАБОЧЕЙ ПЛОСКОСТИ. 

1. Для того чтобы построить 3D модель, в первую очередь необходимо создать 

рабочую плоскость, затем 3D профиль и, наконец, перемещая 3D профиль по 

какой-либо траектории можно получить 3D объект. 

2. Откройте, созданный ранее файл Цилиндр.grb. Если кнопка (погасить 

построения) находится в нажатом состоянии, отожмите ее. 

Положение рабочей плоскости (РП) 

в пространстве, как известно, 

определяют три точки. В нашем 

случае точки задавать не нужно, т.к. 

рабочая плоскость будет совпадать 

с плоскостью чертежа, ориентация 

которой системе известна. 

Для начала, необходимо задать 

границы рабочей плоскости. 

Постройте относительно линии 

торца цилиндра параллельную 

прямую и параллельную прямую 

относительно нижней линии 

наружного диаметра цилиндра, или 

другими словами отложите две 

линии построения от наружного 

контура цилиндра (см. рис.). 

Построенные линии будут являться 

правой и нижней границами РП. 

Вверху и слева РП будут 

ограничивать контуры листа. 

 

Создайте РП: Построение/Рабочая плоскость или нажмите на панели инструментов. В 

появившемся Автоменю, выберите опцию . Откроется окно «Стандартные рабочие 

плоскости». Поставьте галочку напротив названия РП «Спереди» и нажмите . 

 

 

http://www.tflex-nord.narod.ru/html/education/education_02/lesson_01/zilindr_2d.zip


Подведите курсор к пересечению линий задающих границы РП и нажмите . Появиться 

изображение рабочей плоскости, выделенное красным цветом, нажмите в Автоменю. 

Теперь откройте 3D окно: Окно/Разделить по вертикали. В появившемся диалоге «Создать 

окно» выберите – 3D Окно. Откроется 3D окно. 

 

Если вы создавали чертеж цилиндра на основе прототипа подключенного в п. 4.4 «Начальный 

курс. Часть I Параметрическое черчение», то в 3D окне вы увидите рабочую плоскость. Если 

чертеж цилиндра создан на основе прототипа поставляемого с системой, то РП видно не 

будет, что в данном случае не критично. В прототипе, поставляемом с системой, в свойствах 

РП не поставлена галочка «Показывать на 3D виде». РП есть, просто она не отображается в 

3D. 

После того как вы построили рабочую плоскость можно приступать к созданию 3D 

построений. Цилиндр – тело вращения. Значит необходимо построить два 3D узла задающих 

ось вращения. Выполните следующее: Построение\3D Узел или нажмите на панели 

инструментов. Далее укажите первый 2D узел, на основе которого будет построен 3D узел. 

Например, укажите левый узел пересечения торцевой и осевой линии (см. рис. ниже) и 

нажмите в Автоменю. Затем выберите второй 2D узел (правый) и нажмите в 

Автоменю.  

 

Так как для создания данной 3D модели используется одна рабочая плоскость – 

достаточно указывать одну проекцию 3D узла. 
 

 

 

Теперь, когда построены 3D узлы, построим 3D профиль и привяжем его к одному из 3D 

узлов. 3D профиль создается на основе 2D штриховки. Цилиндр получается вращением 3D 

профиля вокруг оси, заданной двумя 3D узлами. Поэтому создадим одноконтурную 

штриховку, а чтобы создаваемая штриховка не затеняла собой разрез на чертеже, сделаем ее 

невидимой. 

Постройте контур штриховки, как это показано на рис. ниже, выберите для штриховки 



параметр «Невидимая» и нажмите в Автоменю. 

 

Постройте 3D профиль на основе только, что созданной штриховки: Построение/3D 

Профиль или нажмите на панели инструментов. Щелкните по штриховке . В 2D окне 

штриховка выделится цветом, а в 3D – появится изображение 3D профиля. 

  

 

Если выбралась не та штриховка – нажмите на клавиатуре клавишу с латинской 

буквой «I». Каждый раз, когда вы нажимаете клавишу «I» будет выбираться 

ближайший элемент того же типа. 

  
 

 

 

После того, как вы выбрали нужную штриховку, и в 3D окне появилось изображение 3D 

профиля, укажите курсором 3D узел для привязки 3D профиля, затем нажмите в 

Автоменю. 



Для создания тела выполните следующее: 

Операции/Вращение или нажмите на панели 

инструментов. В 3D окне укажите  3D профиль, затем 

первый 3D узел , второй 3D узел , выберите материал 

в верхней части рабочего окна программы (см. рис.).  

 

Система покажет предварительный результат операции 

вращения. Для завершения операции нажмите в 

Автоменю. В 3D окне будет создана 3D модель цилиндра в 

реберном изображении.  

 

Для того чтобы система отображала цилиндр в тоновой 

закраске соответствующей материалу, запустите команду 

Вид/Изображение/Тоновая закраска с материалами или 

нажмите на панели инструментов в правой части экрана. 

Чтобы вернуть реберное отображение модели выполните 

Вид/Изображение/Реберное изображение или . 

 

Вы научились создавать тело операцией «Вращение», а теперь, на примере сквозного 

отверстия в стенке цилиндра, вы научитесь выполнять операцию «Выталкивание» совместно с 

«Булевой» операцией. 

Начертите отверстие в стенке цилиндра, как это показано на рисунке. Затем нанесите 

штриховку на окружность отверстия с параметром «Невидимая». Создайте 3D профиль, 

указав на штриховку окружности, и привяжите 3D профиль, например, к первому 3D узлу. 

 

 



 

 

Вызовите команду Операции/Выталкивание или нажмите . В 3D окне укажите  3D 

профиль. Система покажет направление выталкивания по умолчанию. Направление 

выталкивания можно сменить кнопкой , в появившемся окне «Параметры выталкивания». 

В этом окне задайте «Длину» выталкивания в основном и обратном направлениях (см. рис.). 

 

 

 

 

 

 
 

 

При создании выталкивания для получения отверстий длину выталкивания лучше 

задавать немного больше размеров основной детали. 
 

 

Находясь в команде «Выталкивание», можно выполнить 

«Булеву» операцию (сложение, вычитание, пересечение) с 

другим телом. Для этого в Автоменю из выпадающего списка 

выберите опцию «Вычитание» (см. рис.). 

 

 

 
 



 

Затем, выбрав в Автоменю опцию , 

укажите тело, из которого будете 

вычитать выталкивание (тело при этом 

выделится желтым цветом), в нашем 

случае цилиндр и завершите команду . 

Отверстие будет создано. 

 

 

 

 



ПРАКТИЧЕСКАЯ РАБОТА №3 

СОЗДАНИЕ 3D МОДЕЛИ ПО СУЩЕСТВУЮЩЕМУ 

ЧЕРТЕЖУ НА ОСНОВЕ ДВУХ РАБОЧИХ ПЛОСКОСТЕЙ. 

Откройте файл Плита 2d.grb. При создании 3d модели по данному чертежу удобнее 

использовать две рабочие плоскости (РП). Если кнопка (погасить построения) 

находится в нажатом состоянии, отожмите ее. 

 Для начала, необходимо задать 

границы рабочих плоскостей. 

Постройте прямую, как ось 

симметрии относительно красной и 

синей линий построения или 

другими словами постройте линию 

построения посередине между 

видами спереди и сверху (это будет 

граница между РП). Также, 

отложите прямую от правого торца 

плиты (это будет правая граница 

РП). (См. рис.). 

 

Создайте РП: Построение/Рабочая плоскость или нажмите на панели инструментов. В 

появившемся Автоменю, выберите опцию . Откроется окно «Стандартные рабочие 

плоскости». В окне нажмите кнопку «Спереди и сверху». 

 

 

Подведите курсор к пересечению линий задающих границы РП и щелкните . Появиться 

изображение рабочих плоскостей, выделенное зеленым цветом. Граница между рабочими 

плоскостями будет проходить, как раз посередине между видами спереди и сверху. 

Теперь откройте 3D окно: Окно/Разделить по 

вертикали. В появившемся диалоге «Создать окно» 

выберите – 3D Окно. Откроется 3D окно. 

В 3D окне вы увидите две, созданные перпендикулярно 

друг другу, рабочие плоскости. 
 

    
 

http://www.tflex-nord.narod.ru/html/education/education_02/lesson_02/plita_2d.zip


После того как вы построили рабочие плоскости можно приступать к созданию 3D 

построений. Плита – тело, получаемое операцией выталкивания. Для задания границ 

выталкивания необходимо построить 3D узлы. 

 

 

Так как для создания данной 3D модели используются две рабочие плоскости, то 

при построении 3D узла необходимо указывать две его проекции. 

Выполните следующее: Построения/3D Узел или нажмите на панели инструментов. На 

виде спереди, укажите первый 2D узел , например, правый нижний (это будет первая 

проекция 3D узла), затем, на виде сверху – второй 2D узел , например верхний правый 

(это будет вторая проекция 3D узла) и нажмит е  в Автоменю. Затем создайте второй 3D 

узел – вновь выберите на виде спереди правый нижний 2D узел и правый нижний 2D узел 

на виде сверху и нажмите в Автоменю. См. рис. 

 

 

 

Так как штриховка на виде спереди построена «по контуру», не имеет разрывов, а 

отверстия наложены 2D фрагментами, то 3D профиль постройте на основе уже 

существующей штриховки и привяжите его к одному из 3D узлов, как это показано на 

рисунке (см. Урок 1). 

Для создания тела выполните следующее: 

Операции/Выталкивание или нажмите на панели 

инструментов. В 3D окне укажите  3D профиль, 

выберите в Автоменю опцию , укажите  первый 

3D узел (к которому привязан 3D профиль), затем 

 



второй 3D узел  (ограничивающий выталкивание), 

выберите материал в верхней части рабочего окна 

программы (см. рис.). 

Система покажет предварительный результат операции выталкивания. Для завершения 

операции нажмите в Автоменю. В 3D окне будет создана 3D модель плиты в реберном 

изображении. 

 
 

Для того чтобы система отображала цилиндр в тоновой закраске соответствующей 

материалу, запустите команду Вид/Изображение/Тоновая закраска с материалами или 

нажмите на панели инструментов в правой части экрана. Чтобы вернуть реберное 

отображение модели выполните Вид/Изображение/Реберное изображение или . 

Теперь остается построить 3D отверстия и подсчитать массу плиты. 

Для создания 3D отверстий необходимо построить 3D узлы. 3D узлы, в данном случае, 

строятся по двум проекциям (2D узел на виде сверху и соответствующий 2D узел на виде 

спереди). Всего должно получиться шесть 3D узлов. 3D узлы должны «лежать» на грани 

(см. рис.). 

 

 

  

 

Создавая 3D узлы, будьте аккуратны при выборе их проекций – 2D узлов. При 

необходимости – увеличивайте изображение колесиком мыши. 



  
 

 

После того, как построены 3D 

узлы, можно приступать к 

созданию отверстий. Запустите 

команду Операции/Отверстие. 

В Автоменю выберите опцию 

«Насквозь». В «Параметрах 

отверстия» окна «Свойства» 

выберите тип отверстия 

«Резьбовое» и значок отверстия с 

двухсторонней фаской. Задайте 

параметры отверстия, как это 

показано на рисунке.  

Постройте отверстия, 

последовательно указывая  на 

3D узлы, кроме двух, 

предназначенных для отверстий 

под штифты. После того, как вы 

указали необходимые 3D узлы, 

нажмите в Автоменю. 

Для создания отверстий под 

штифты выберите другой тип 

отверстия «Под крепежные 

детали». В параметрах отверстия 

выберите значок отверстия с 

двухсторонней фаской и 

установите диаметр «3.6». 

Укажите 3D узлы и нажмите в 

Автоменю. 

  

 

 

    

 



Теперь подсчитаем массу плиты. Выберите в левой 

части закладку «3D Модель». В дереве 3D Модели 

щелкните по значку «Тело_1». В открывшемся 

контекстном меню выберите «Измерить…». 

 

Откроется окно «Измерение элемента». В колонке «Свойство:» выберите  «mass», 

установите флажок «Создать переменную», присвойте переменной имя «mass» и 

заполните поле «Комментарий» (необязательное действие). 

 

  

Откройте «Редактор переменных» . В редакторе вы увидите созданную переменную 

«mass» c функцией в поле «Выражение», поднимающей значение массы с тела. 

  

 



  

Для задания точности вычислений и передачи значения массы в форматку - допишите 

выражения для переменных «mass» и «$Масса» как это показано на рисунке ниже. 

Система рассчитывает массу в граммах, поэтому необходимо перевести ее в килограммы.  

  

Отредактируйте выражения для переменных «mass» и «$Масса» как написано ниже: 

Round (get (“Тело_1", “mass”)/1000, 0.1) – для переменной «mass» 

Ftoa (mass) – для переменной «$Масса» 

  
 

 

  

 

При работе в «Редакторе переменных» вы можете легко узнать о доступных в T-

FLEX CAD математических выражениях. Для этого нажмите на клавиатуре 

кнопку «F1». Система откроет справку на разделе «Переменные». Найдите в 

тексте ссылку «функции», щелкните по ней . Откроется раздел «Функции 

работы с переменными». В этом разделе щелкните по ссылке 

«Математические функции». Откроется соответствующий раздел, в котором 

описаны различные математические функции доступные в T-FLEX CAD. 

После внесения корректировок в выражения переменных «mass» и «$Масса» закройте 

редактор переменных с сохранением внесенных изменений . 

После этих действий, в штампе форматки, система проставит значение массы плиты. При 

изменении размеров плиты и последующего пересчета модели , значение массы в 

форматке будет изменено автоматически. 



 

 



ПРАКТИЧЕСКАЯ РАБОТА № 4 

СОЗДАНИЕ 3D МОДЕЛИ В 3D ПРОСТРАНСТВЕ. 

Этот способ создания 3D модели является «классическим» для большинства CAD систем. 

Общепринятый подход к 3D моделированию в современных CAD-системах: 

• 3D тела создаются на основе 3D профилей; 

• 3D профили – на основе 2D эскизов (контуров); 

• 2D эскизы создаются линиями изображения на рабочей плоскости или на основе 

геометрии других тел (гранях, ребрах, вершинах). 

В данном разделе вашему вниманию будет представлен способ создания 3D моделей 

отличающийся от официальных способов принятых в других CAD системах и описанных 

в руководстве пользователя по 3D моделированию в T FLEX CAD. 

Предлагаемая схема создания 3D модели выглядит так: 

• на рабочей плоскости создается упрощенный параметрический чертеж на основе линий 

построения; 

• далее создается контур, на основе которого впоследствии системой будет построен 3D 

профиль, но вместо линий изображения для создания контура используется штриховка 

(цветная заливка); 

• 3D профиль система создает автоматически при выходе из режима эскизирования на 

рабочей плоскости, а пользователь, используя 3D профиль в одной из 3D операций, 

получает тело; 

• новые 3D профили пользователь строит не на гранях, вершинах или ребрах 

существующих тел (как это принято), а только на рабочих плоскостях и связывает все 

3D построения, например, положение в пространстве 3D профилей или 3D тел 

относительно друг друга, при помощи переменных. 

Такой подход, конечно, увеличивает (незначительно) время на создание 3D моделей, но 

дает больше свободы действий при моделировании, а главное при редактировании 3D 

моделей и не загоняет конструктора в жесткие рамки определенной разработчиком CAD-

системы последовательности действий при проектировании. 

Например, вы создали сборку, детали которой используют геометрию смежных тел, и 

вдруг понимаете, что где-то вам необходимо построить фаску, а где-то удалить отверстие 

или паз, или вообще изменить состав сборки. При внесении подобных изменений, в 

лучшем случае, ваша сборка перестанет быть параметрической (т.к. разрываются 

геометрические связи), в худшем – вы потеряете часть построений. И это зависит не от 

CAD системы, это зависит от самого принципа проектирования на основе геометрии 

смежных тел. 



На примере создания 3D модели 

штока пневмоцилиндра, вы освоите 

предлагаемый принцип. 

 

При построении 2D чертежа штока 

требуется создание двух проекций: 

вид спереди и вид слева. Поэтому и 

при 3D моделировании будем 

использовать две рабочие плоскости 

(РП): «Вид спереди» и «Вид слева». 

 

  

 

Перед тем как приступать к моделированию примем одно соглашение: все 

построения производятся относительно базовых линий построения, которые в 

свою очередь проходят через начало координат конкретной рабочей плоскости и 

3D пространства в целом. 

  

Что имеется в виду? Как видно из 

рисунка базовые линии построения 

проходят через начало координат, как 

рабочих плоскостей, так и 3D 

пространства в целом. Поэтому если 

вы создали какие-либо построения на 

рабочей плоскости относительно 

базовых линий, а затем перешли на 

другую рабочую плоскость, где также 

все построения создали относительно 

базовых линий, то вам не придется 

заботиться о соответствии построений 

на одной рабочей плоскости с 

построениями на другой. Все ваши 

построения, в конечном счете, будут 

созданы относительно начала 

координат 3D пространства в целом. 
 

  

 

Перед началом работы по созданию 3D модели рекомендуется выполнить 

эскиз детали карандашом на бумаге. На эскизе проставьте размеры от 

конструкторских и (или) технологических баз и напишите у каждого 

размерного числа уникальный параметр, например, d1=10, b1=40, l1=120 и 

т.д. (см. рис. ниже). Если вы строите 3D модель по имеющемуся бумажному 

чертежу – нанесите карандашом размеры с параметрами прямо на 

чертеже. На начальном этапе освоения системы возьмите подобное 

эскизирование за правило, и вы значительно облегчите себе работу. 

  



 

Обратите внимание – некоторые размеры имеют одну стрелку. Так, графически можно 

изобразить зависимость построений относительно конструкторских и технологических 

баз. На рисунке, размер «l=170» строиться от правого торца основного диаметра «d=25» в 

левую сторону, размер «l1=40» – от того же торца, но в правую сторону, т.к. выбранный 

торец является конструкторской базой. 

Теперь перейдем непосредственно к 3D 

моделированию. Создайте новый 

документ на основе прототипа «Новая 

3D модель»: Файл/Новый из 

прототипа/Новая 3D модель. Создание 

прототипов было описано в первой 

части пособия «Начальный курс. 

Параметрическое черчение» п.4.4. 

Откроется 3D окно системы T FLEX 

CAD. В окне вы увидите три взаимно 

перпендикулярные рабочие плоскости: 

«Вид спереди», «Вид слева» и «Вид 

сверху». 

Выше отмечалось, что для создания 3D 

модели штока понадобятся две рабочие 

плоскости: «Вид спереди» и «Вид 

слева».  

Основные построения (параметрический 

чертеж, контур и соответственно 3D 

профиль) будут созданы на рабочей 

плоскости «Вид спереди». 

 

Убедитесь, что кнопка объектной привязки и кнопки селектора 

находятся в нажатом состоянии. 

Подведите курсор мыши к рабочей плоскости «Вид спереди». После того, как система 

выделит цветом рабочую плоскость, щелкните по ней и выберите в контекстном меню 

«Чертить на рабочей плоскости». 



 

Система развернет выбранную рабочую плоскость 

параллельно экрану. Станут, доступны команды для 2D 

построений и панель «Управление активной рабочей 

плоскостью».   

Вы можете создавать построения на рабочей плоскости на фоне 3D пространства (по 

умолчанию). Но все же, удобнее открыть 2D окно с текущей рабочей плоскостью (РП). 

Для этого нажмите на панели «Управление активной рабочей плоскостью» кнопку - 

откроется 2D окно с активизированной РП. Если вы создали документ на основе 

прототипа, приложенного к пособию и подключенного к системе, см. «Начальный курс. 

Часть I» п.4.4, то увидите на плоскости две базовые линии красного цвета, проходящие 

через начало координат выбранной РП.  



 

 

 

Если вы воспользовались другим прототипом или по какой-то другой 

причине базовые линии отсутствуют, то постройте базовые линии 

самостоятельно: Построения/Прямая или нажмите на панели 

инструментов. 

 

Далее в Автоменю выберите - откроется Подменю с 

дополнительными опциями (см. рис.). В открывшемся Подменю 

нажмите , и система построит две пересекающиеся прямые 

проходящие через начало координат РП, далее щелкните , 

чтобы выйти из команды. Теперь измените свойства линий 

построения: цвет красный, длина - «Бесконечная», см. «Начальный 

курс. Часть I» п.4.3 “Настройка базовых линий”. 

Создайте параметрический чертеж контура штока, присваивая параметрам прямых имена 

переменных (l, l1, l3, d, d1, d3). Желательно заполнять поле «Комментарий» у каждой 

переменной, чтобы впоследствии было удобнее работать с документом. Построения 

начинайте от базовых линий (б.л.), см. рисунок. Как вы уже знаете, для создания тел 

вращения достаточно откладывать только половину диаметра. Естественно значение 

переменной, например, «d3» будет равняться 14, а в параметрах прямой указывается 

«d3/2». 

 

После создания линий построения, обведите контур штриховкой (заливкой), как это 

показано на рисунке выше. 



Затем постройте фаски, см. рис. ниже. 

 

  

Шток – тело вращения и для того, чтобы при создании операции вращения в 3D 

пространстве можно было задать ось вращения необходимо построить два 3D узла. 

Зайдите в команду Построения/3D Узел укажите, например, левый 2D узел (см. рис.),  

 

  

затем нажмите в Автоменю, далее укажите второй узел – правый (см. рис.) 

 

и нажмите в Автоменю.  

  

Теперь необходимо построить отверстие проушины. 

Вначале разделите расстояние между двумя 

вертикальными линиями на две равные части, т.е. 

постройте прямую, как ось симметрии двух прямых. 

Для этого зайдите в команду Построения/Прямая или 

нажмите на панели инструментов, подведите курсор 

к первой вертикальной линии, выберите  ее, затем 

подведите ко второй вертикальной линии – также  

выберите ее – система разделит расстояние между 

прямыми на две равные части.  

Постройте окружность «d2/2» с центром на 

пересечении построенной прямой и базовой линии. 

Обведите окружность штриховкой (выберите заливку 

другого цвета, в системной панели в верхней части 

экрана). 
 

 
  

Вы построили два контура. Теперь для того, чтобы на 

основе построенных контуров система создала два 3D 

профиля, достаточно завершить черчение на рабочей 

плоскости, нажав на панели «Управление активной 

рабочей плоскостью». 
 



После завершения черчения на РП, в 3D пространстве вы увидите два 3D профиля: 

профиль для создания тела вращения и профиль для создания отверстия операцией 

выталкивания. 

 

Вначале создайте операцию «Вращение»: Операции/Вращение или нажмите на 

панели инструментов. Вначале, выберите 3D профиль для создания тела штока.  

Затем задайте ось вращения: укажите первый 3D узел 

, потом второй 3D узел , выберите материал в 

верхней части рабочего окна программы (см. рис.). 

Система покажет предварительный результат операции 

вращения. 

 

 

Для завершения операции нажмите в Автоменю.  

 



Отверстие проушины можно получить при помощи операции выталкивания совместно с 

булевой операцией. Вызовите команду Операции/Выталкивание или нажмите . 

Чтобы было удобнее выбрать 3D профиль отверстия, верните реберное отображение 

модели: Вид/Изображение/Реберное изображение или нажмите . 

Укажите  на 3D профиль отверстия. В «Основных параметрах» операции выталкивания 

в списке выберите через все, как показано на рисунке. Затем в Автоменю нажмите и 

укажите на тело штока – система выделит тело желтым цветом. Для завершения операции 

нажмите в Автоменю. 

 

 

 

Верните отображение 3D модели в режим «Тоновой закраски с материалами» - нажмите 

на панели инструментов в правой части экрана.  

 



Теперь необходимо удалить часть «материала», чтобы получить проушину. Для этого 

постройте 3D профиль, создайте на его основе тело, которое будет вычтено из полученной 

3D модели. 

3D профиль удобнее создать на РП «Вид слева». Подведите курсор к РП «Вид слева» и 

когда система выделит ее цветом, вызовите контекстное меню. В меню выберите 

«Чертить на рабочей плоскости». 

Для удобства работы откройте 2D окно с текущей 

рабочей плоскостью: нажмите, в появившейся панели 

«Управление активной рабочей плоскостью» кнопку 

. 
 

 

 

  

Для создания 3D профиля постройте окружность с параметром «d3/2» (d3=25) на 

пересечении базовых линий. Затем от вертикальной базовой линии отложите линию 

построения с параметром «s/2» (s=5). Используя опцию в Автоменю, постройте 

симметричную прямую. Создайте двухконтурную штриховку (см. рис.) – обведите одной 

штриховкой оба сегмента. После этих действий контур будет построен. 

Так как контур был построен для создания тела операцией выталкивания и построен в 

единственном числе, то можно сразу зайти в команду «Выталкивание»: 

Операции/Выталкивание или нажать на панели инструментов. Система закроет 

текущую РП и запустит команду «Выталкивание» на выполнение – в 3D окне появится 

предварительный результат выталкивания на заданное расстояние (по умолчанию 10). 



В нашем случае необходимо сместить начало 

выталкивания от РП «Вид слева» на 

расстояние «l=170» и задать длину 

выталкивания «l3=14» (см. выше начало 

раздела – нанесение размеров с параметрами 

на чертеж). 

 

Находясь в команде «Выталкивание», откройте окно «Параметры выталкивания», нажав 

на клавиатуре «P» или опцию - в Автоменю. Далее перейдите на закладку 

«Преобразование». В разделе «Смещение» в поле «Х» задайте смещение параметром «l», 

которое, как мы условились, равняется 170. В данном случае параметр имеет 

положительный знак, т.к. направление смещения совпадает с направлением оси Х 

глобальной системы координат 3D окна. 

 

  

Параметры смещения заданы. Теперь можно задать параметры самого выталкивания. Для 

этого перейдите на закладку «Операция». Эта закладка дублирует окно «Свойств» в левой 

части экрана. В поле «Длина» проставьте параметр «l2» равный 14 и нажмите . 



 

Система покажет предварительный результат операции «Выталкивание». 

 

  

 

Так как все построения велись от базовых линий с использованием переменных, 

смещение выталкивания совпадает с левым торцом основного диаметра штока. 

  

Находясь в команде «Выталкивание», выполните «Булеву» 

операцию - вычитание с телом штока. Для этого в Автоменю из 

выпадающего списка выберите опцию «Вычитание» (см. рис.). 

Затем, выбрав в Автоменю опцию , укажите тело штока, из 

которого будете вычитать выталкивание (тело штока при этом 

выделится желтым цветом) и завершите команду .  



 

Если вы выполняли построения согласно описанию, то теперь, изменив в «Редакторе 

переменных» значение «170» параметра «l» на значение, например, «100» и 

соответственно обновив модель , получите новую модификацию штока. Таких 

модификаций вы можете получить сколько угодно, ведь все построения – 

параметрические, и созданы относительно начала координат каждой РП в частности и 3D 

пространства в целом. 

Для завершения работы над 3D моделью штока осталось создать резьбу. В T FLEX CAD 

существует 3D операция «Резьба». Вы можете создать на 3D модели имитацию резьбы в 

виде текстуры, затем при получении 2D проекций система автоматически создаст 

изображение резьбы в соответствии с ГОСТом. 

Запустите команду Операции/Резьба. Подведите курсор ближе к наружному краю грани, 

на которой будет создана резьба, и щелкните , см. рисунок ниже. Прозрачной стрелкой 

и спиральной линией система покажет направление наложения текстуры резьбы. 

 

 

  



 

В окне «Параметры резьбы» в левой части экрана 

вы можете задать необходимые значения. Диаметр 

резьбы система подбирает автоматически, в 

зависимости от диаметра указанного цилиндра. 

Шаг по умолчанию – основной. 

Укажите длину резьбы. Для этого в параметрах 

резьбы в разделе «Конец» установите параметры 

«От конца» на расстояние «l2» равному «14», см. 

рисунок. Система покажет отступ окончания 

резьбы от торца основного тела штока, равный 

«14». 

 

Теперь, когда заданы параметры резьбы, завершите операцию, нажав в Автоменю. 

Система отобразит текстуру резьбы, при этом количество витков будет зависеть от шага и 

длины резьбы. 

 

На примере создания 3D модели штока, вы научились строить новые 3D профили не на 

гранях, вершинах или ребрах существующих тел (как это принято), а только на рабочих 

плоскостях и научились связывать все 3D построения (положение в пространстве 3D 

профилей), при помощи переменных. При помощи переменных вы можете задавать 

положение в 3D пространстве не только 3D профилей, но и других 3D элементов 

построения (3D узлов, ЛСК, РП), а также 3D операций (выталкивание, 3D фрагменты). 



 

 

 



 КОНТРОЛЬНЫЕ ВОПРОСЫ 

Дайте определение и понятие следующих элементов системы T-FLEX CAD: 

 

2D вид 

3D вид 

3D сцена 

Рабочие плоскости 

Стандартные рабочие плоскости 

Дополнительные рабочие плоскости 

Рабочие плоскости по 2D проекции 

Рабочие плоскости по 3D системе координат 

Рабочие плоскости на основе плоских граней тела. 

Вспомогательных 3D элементов 

3D узлы 

3D профиль 
3D система координат - локальная система координат 

Сечение 

3D путь 

Источник света 

Камера 

Операция выталкивания 

Операция вращения 

Операция создания линейчатой поверхности 

Операция создания лофтинга 

Операция создания тела по траектории   

Операция создания спирали 

Операция создания пружины 

Операция создания трубопровода   

Операция создания каркасной поверхности   

Булевы операции 

Сглаживание 

Создание копии 

Создание 3D фрагмента 

3D фрагмент 

Создание массива   

Создание массива вращения 

Вставить внешнюю модель 

Вставить 3D изображение 

Отсечение операции 

Наложить материал 



Список рекомендуемой литературы. 

 

1.1 Рекомендуемая литература. 

14.1.1Основная литература. 

 Головицына М.В. Основы САПР. – М.: БИНОМ – Лаборатория 

базовых знаний, ИНТУИТ.РУ «Интернет-университет 

информационных технологий», 2008. 

 14.1.1Основная литература. 

 Романычева Э.Т. Компьютерные технологии инженерной графики в 

среде AutoCad 2.- М.,2007. 

 Залогова, Л. А. Компьютерная графика : практикум / Л. А. Залогова. – 

2-е изд. – М. : БИНОМ. Лаборатория знаний, 2007. – 245 с.  

 Методическая литература. 

 Методические указания по выполнению лабораторных работ в T-Flex 

Cad 3D 

 Методические указания по выполнению практических работ в T-Flex 

Cad 3D 

 Электронный учебный курс Невинномысск: НТИ «СКФУ», 20__ 

 Вспомогательная литература 

 T-FLEX CAD о «Трехмерное моделирование» Руководств пользователя 

o Средства обеспечения освоения дисциплины 

 - Программа дисциплины по курсу 3D моделирование в 

промышленности; 

 - Методические указания по лабораторным работам курса; 

 - Электронная версия курса лекций, выполненная на кафедре 

ХТМАХП. 

o Материально-техническое обеспечение дисциплины 

 Компьютерный класс 

 САПР T-Flex. 

 

 

3. Методическая литература:  

1. Методические указания по выполнению практических работ по 

дисциплине "3D-моделирование в промышленности" для студентов 

заочной формы обучения,  направления подготовки 15.03.02 

Технологические машины и оборудование. Е.С. Антипина г. 

Невинномысск, 201__. 

2. Методические указания для студентов по организации  

самостоятельной работы по дисциплине "3D-моделирование в 



промышленности" для студентов заочной формы обучения, 

направления подготовки15.03.02 Технологические машины и 

оборудование. Е.С. Антипина г. Невинномысск, 201__. 

3. Методические указания по выполнению лабораторных работ по 

дисциплине "3D-моделирование в промышленности" для студентов 

очной формы обучения, направления  подготовки 15.03.02 

Технологические машины и оборудование Е.С. Антипина., г. 

Невинномысск, 201__. 

4.  Интернет-ресурсы:  

1. http://window.edu.ru/ – Единое окно доступа к образовательным ресурсам.  

2. www.biblioclub.ru – Электронно-библиотечная система «Университетская 

библиотека онлайн». 

3.www.e.lanbook.com – Электронно-библиотечная система «Лань» 

4.catalog.ncstu.ru – Электронный каталог фолиант СКФУ 

5.www.library.stavsu.ru – Электронная библиотека и электронный каталог 

научной библиотеки СКФУ  
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для студентов по организации самостоятельной работы 

 по дисциплине «3D-моделирование в промышленности» 

для студентов заочной формы обучения направления подготовки  

15.03.02 Технологические машины и оборудование 
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